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Using Help 
The following sections describe how to use options from the Giza Help menu and the Giza help Toolbar. 

   

The question mark - Topics option/icon  in the Help toolbar takes you to the Contents page of this 
help file. 

 
See also: 

 Help toolbar 

 What's new 

 Community 

 2020 on Social Media 

 Training 

 Support 

 Check for software updates 

 Check for catalog updates 
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Help toolbar 

For the most part, the Help toolbar offers the same options as the Help menu. 

 
You can move this toolbar as you would for other Worksheet toolbars by clicking and holding the dotted 
line on its left. 

See Using Help 

What's new 

From the Help menu, click What’s New. From the window shown below, you can: 

 view announcements on 2020 Technologies commercial software 

 read about and download manufacturer catalog updates 

 view information about new commands, software fixes and known issues 

 download software or catalog updates. See also Check for software updates, Check for catalog 
updates 

 download PDF versions of the 2020 Technologies commercial software user manuals 

 download PDF files of Release Notes (What's New) as they become available 

 find training courses for 2020 Technologies software 

 view a list of upcoming industry events in which 2020 Technologies will participate 

 obtain 2020 Technologies' contact information 
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Community 

This Help option takes you to the Cube forum of the 2020spaces web site where you can find and share 
information on 2020 Commercial Software (Office) products and its community. 

 

 

2020 on Social Media 

As this is the trend in software applications, the options offered take you to various 22020 social media 
plate-forms so you can stay informed and share as you deem appropriate. 
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Training 

The 2020 Training option takes you to the 2020 Training page of the 2020 website where you can see 
scheduled training, sign up for classes, and learn more about what each class offers. 

The Training Videos option takes you to the e-learning page of the 2020 website where you can watch 
videos that provide basic information about the Giza functionality. 
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Support 

The Live Chat option opens a web page where you are required to enter information in preparation for 
starting a live chat with a Support agent.  

The Email Us option opens a web page where you can send 2020 an e-mail regarding an issue and to 
access the 2020 Community page. 

 

 



7 

 

Check for software updates 
From the Help menu select Check for Software Updates. 
 
The Update Manager appears. From here you can view updates for your system, view update descriptions 
and download and install updates. 
 
For help on Update Manager click on the Help link on the bottom right of the Update Manager window. 

Check for catalog updates 

From the Help menu select Check for Catalog Updates. 
 
The Update Manager appears. From here you can view catalog updates for Giza Designer, update 
descriptions, time and file size. 
 
For help on Update Manager click on the Help link on the bottom right of the Update Manager window. 
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2020 Giza Designer 
2020 Giza Designer is the non-AutoCAD based design tool. It helps users to create an accurate bill of 
materials based on the drawings. You can create various views as well as page layouts depending on the 
customers’ specific requirements. 

See: 

 2020 Giza Overview 

 2020 Giza Designer Toolbars 

 Menus Overview– 2D CAD, Walls, Furniture Placement 

 Draw Lines 

 Edit – Delete/Copy/Move 

 Fillet 

 View Commands 

 Save Drawings 
 

Overview 
Welcome to the 2020 Giza Designer Online Help. This file is designed to fit the needs of space planners, 
sales people, facility managers, and designers. You will develop furniture quotations, budget proposals, 
orders, and other documents used in the design, sales, specification, and management of systems 
furniture. 

We will provide the detail assistance necessary for you to increase your production and give you a solid 
base for learning advanced features and techniques. 

All users should have basic familiarity with the concepts and practices of modern business office design 
and product knowledge. 

 2020 Giza Designer is the ideal tool for sales people. Some of the features include Icon Menus to aid 
product selection for particular product lines. The Panel Placer tool allows for accurate panel 
placement. Auto Hardware is included for some product lines that automatically place panel 
connectors. Panel Checker alerts you when overlapping panels occurs to aid you in determining 
proper panel placement. Frame Designer allows you to build frames up with skins when available. 
Products brought into the drawing area are brought in on layers that allow for easy viewing and 
editing. You have the ability to place parts or typicals in a grid configuration easily. Multiple views can 
be generated including 2D, 3D, hidden line and 3D color views. Parts lists can be exported to 
Worksheet, Microsoft Excel or Word. The media menu allows access to a catalog of typical 
workstations that can be placed for ease of presentation. 
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 2020 Giza Designer includes the ability to share AutoCAD drawings. It is the most popular drafting 
tool for both sales and design professionals. Enhanced allows you to work smoothly with designers 
and architects who use AutoCAD by importing and exporting to .dwg and .dxf format. The software 
also aids by creating smart 3D architecture that will help to create walls, windows, doors, and 
columns. Three-dimensional renderings generate realistic shadows. Perspective cameras let you 
control the viewpoint to get realistic previews and print outs. A Bill of Materials report allows for a 
parts list and base pricing to gain a quick estimate. Designer also has an inventory function that can 
compare two drawings to determine what can be reused. 

 2020 Giza Designer can also meet the needs of the most demanding users who need to modify 
standard catalog items and generate high-end presentations. Designer allows you to create custom 
items by stretch, rename, and specify items to meet exact client requirements. It includes 2020 Giza 
Publisher, which gives you the ability to print full-color presentations and marketing materials using 
built-in templates. 
 

Main Screen 
Most commands can be accessed from menu options or Toolbar buttons. For a complete list of buttons 
see Toolbars. 
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Toolbars 

 Standard Toolbar 

 View Toolbar 

 Tools Toolbar 

 Drawing Toolbar 

 Furniture Toolbar 

 Walls Toolbar 

 Help toolbar 

 Customize Toolbars 

Standard Toolbar 

 

Stop  
The Stop button ends the current operation. The ESC key also performs this function. You may also click 
Stop to deselect highlighted items in the drawing. 

Undo  
Click this button to undo past commands in your drawing. You may reverse up to 30 commands in the 
drawing. This function can be very useful if you discover that you made a mistake some time earlier in 
your drawing process: you may simply undo commands until you reach the point where you wish to 
start again. You may also access this function by selecting Undo from the Edit Menu. If you undo a 
command you wish to keep, simply click the Redo button, right next to Undo on the Toolbar. 

Redo  
Click Redo to reinstate commands you have removed using the Undo function. You may reinstate up to 
30 undone commands. 

New  
Click this button to create a new drawing. If applicable, you will be prompted to save the existing 
drawing. 

Open  
Click this button to open an existing drawing without having to go through the File menu. Choose Open 
to open a drawing, Typical, DXF file, DWG file, defaults file, view file, bitmap image file, color map file, or 
Hidden Line file. 
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Save  
Click this button to save the current drawing without having to go through the File menu. Use the Save 
command to save your drawing with a .cdb extension. If this is a new drawing, the Save As dialog 
appears and you are prompted for a name for the drawing. 

Check and Save  
Click this button to run a Drawing Integrity Check before saving. The ‘Drawing Integrity Check’ dialog 
appears, allowing you to check your drawing for various problems. When the check is complete, the 
drawing is saved or, if not previously saved the Save As dialog appears. 

Import/Export/Style Files  
Click this button to load and save styles and special files. 

Print  
Click this button to access the Print function without having to go through the File menu. The Print 
Drawing dialog appears, or the Print dialog if a Render window is active. 

Print Preview  
This function shows you an approximate image of what your print will look like. The magnifying glass 
function allows you to zoom in and examine areas of the potential print image. 

Set Options  
Click Set Options to bring up the Options dialog, where you may set your preferences for Giza. 

Load Help System  
Click this button to access the help file. 

View Toolbar 

 

Activate 2D Window  
Click this button to switch focus to the 2D window. A new 2D window is created if none currently exists. 

Activate 3D Window  
Click this button to switch focus to the 3D window. A new 3D window is created if none currently exists. 
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Create Hidden Line  
Click the Create Hidden Line button to execute a Hidden Line Drawing. A Hidden Line drawing (a black 
and white 3D view with solid faces) of the current 3D drawing window is generated. If the Hidden Line 
process is already in progress, an error message is displayed.  
This process may take some time on larger drawings, and prompts indicating progress appear in the 
status line. 

Render 3D Window  
Click the Render 3D Window button to execute a Full Color Shaded Rendering. The Rendering process is 
invoked to create a shaded image of the current 3D drawing window. If the Render process is already in 
progress, an error message is displayed. This process may take some time on larger drawings, and 
prompts indicating progress appear in the status line. The Render tab of the Options dialog (called from 
the Tools menu) is used to set up rendering parameters. 

Lightscape Rendering 
Click this button to launch the Lightscape Visualization Module (Professional Only), which creates an 
advanced, shaded color image of the 3D Drawing Window. Lightscape renderings help you visualize the 
effects of lighting on the furniture in your drawing. 

Select Window  
Click Select Window to choose an active window. This is a convenient function if you prefer to have 
windows maximized, but keep more than one type of window open. The Choose Window dialog 
appears, showing you a list of the windows you have open. Click the desired window, and it is brought to 
the top. 

Redraw Window  
Click the Redraw Window button to redraw the current drawing window. This function is useful for 
redisplaying the drawing when you have made changes, especially erasing, that may not be properly 
visible until the screen is redrawn. 

Zoom All  
Click the Zoom All button to zoom the drawing window so that all items in the drawing fit into the view. 
The scale of the view in the current window is recalculated so that all elements in the drawing fit within 
the display window. Elements in layers, which are not on for display, are not included. 

Zoom Area  
Click the Zoom Area button to zoom in on an area of the drawing window. You are prompted to define 
the corners of a rectangular area, which then fills the window. The scale of the view is adjusted so that 
the area selected fits just within the display window. The rotation of the view is not affected. 

Zoom In  
Click the Zoom In button to make items displayed in the current window appear larger. The scale of the 
view in the current drawing window is increased. The rotation of the view is not affected. The amount 
the view scale is increased can be configured on the View Setups dialog. 
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Zoom Out  
Click the Zoom Out button to make items displayed in the current window appear smaller. The scale of 
the view in the current drawing window is decreased. The rotation of the view is not affected. The 
amount the view scale is decreased can be configured on the View Setups dialog. 

Rotate View    
Click one of the two Rotate View buttons to rotate the view in the current drawing window either 
counter-clockwise or clockwise. The View Control dialog provides additional controls for adjusting the 
view in different directions. 

Swap View  
Click the Swap View button to Swap between the current view and the last view. 

Perspective Camera  
Click the Perspective Camera button to bring up the Perspective Camera icon. The camera icon appears, 
and a Perspective view window is added to the drawing. Manipulate the camera icon to control the 
contents of the Perspective window. 
The Camera dialog also appears where you may set parameters for the Perspective Camera. 

Birdseye View  
Click Birdseye View to bring up a Perspective window, showing a Birdseye view of the drawing. 

View Control  
Click this button to bring up the View Control dialog, allowing you to set the view. 
The View Control dialog provides controls for manipulating the display in the current drawing window. 
Standard view angles can be selected. Incremental rotation around the view or the drawing axes can be 
performed. View scale can be increased or decreased. View control parameters can be modified. 

Tools Toolbar 

 

Vignette Print  
Select this button to create a Vignette print of your drawing. The Print Vignette Sheet dialog appears, 
allowing you to set the parameters for plotting your drawing. 

Publisher  
Publisher is an application within Giza Design designed to allow you to print detailed reports, complete 
with illustrations of your drawings, in a layout and format you control. For more information on 
Publisher and how to use it, see the Publisher chapter. 
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Furniture Placement  
Click the Furniture button to display the current furniture product line menu. This button has been 
added so that you may go directly to furniture placement if you are in another mode, such as 2D 
Drawing. 

Select  
Click the S button to bring up the Select dialog, where you can place symbols by part number. You may 
use this function to place a symbol without having to locate it on a library menu. 

Panel Placement  
Click the Pnl button to bring up the Panel Placement dialog, where you may place panels automatically. 
You may also access this function from the Draw menu. 

Frame Designer  
Select Frame Designer to bring up the Frame Designer dialog, where you may apply frame designs to 
panels in your project. See the Frame Designer section for more information. 

Draw Walls  
Click this button to activate the Wall Drawing application. This button has been added so that you may 
go directly to Wall Drawing mode, without having to go through the Draw Menu. 

Draw CAD  
Click this button to activate the 2D Drawing (CAD) application. This button has been added so that you 
may go directly to drawing mode, without having to go through the Draw Menu. 

Add Image  
Select Image to bring up the Add an Image dialog. Here, you can select a .bmp or .jpg image and place it 
in your drawing. 

Point Input  
Click this button to bring up the Point dialog. This dialog allows you to enter exact X (horizontal) and Y 
(vertical) distances, used in many Giza Design functions. 

Set Snap and Reference  
Click this button to activate the Snap/Set Reference dialog. When using the status line for distance 
input, the relative distance is measured from the reference point, which is usually the last point entered. 
To set a different reference point, click the Set Reference button, and then enter the new point. Several 
different references (Midpoint, End Point, etc.) are available. See the Point Input section for more 
information. This command may be executed in the middle of another command—such as running 
line—to set a reference point and then continue with the previous command. 
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Measure Distance  
Use this function to measure distances or items in your drawing. Click on the start and finish locations of 
the length you wish to measure. You may right-click to snap to the corner of an item you wish to 
measure, to ensure an exact measurement. The Measure Distance dialog appears and displays the 
length measured, the horizontal and vertical distances, the elevation and the angle of the area defined. 
This function is also available under the Tools Menu. 
Note: It is recommended that you measure items without the Ruler function (on the Lower Status Bar) 
enabled, as the Ruler can affect measurements in the drawing. 

Special Symbol Creation  
Select Special Symbols to launch Giza Specials, which contains special functions to create and modify 
custom furniture symbols for Giza. See the Giza Specials topic for more information. 

Worksheet  
Click this button to launch Worksheet. Worksheet allows you to determine the cost of all the items in 
your drawing and generate pricing reports. For more information on how to use Worksheet, access the 
help system after you have launched Worksheet. 

Update from Visual Worksheet  
To update the current drawing with any finish changes made in 2020 Worksheet or Visual Impression. 

Create Scene Bond  
To organize your drawing into scenes around different points of interest that you want to call attention 
to when viewing in Visual Impression. 

Manage Scenes  
To add or delete a scene for Visual Impression. 

2020 Visual  
To open Visual Impression. 

Media Program  
Click Media Program to open the Media Program application, which allows you to access pictures of Giza 
furniture and layouts. There are Typicals associated with these pictures, which can be placed in your 
drawing. 

Inventory  
Click the Inventory button to access the Inventory comparison application. Inventory allows you to 
compare two projects. This gives you the option of reusing furniture components, reducing the number 
of new components you must purchase. 
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Load Layer Dialog Box  
This button brings up the Layer Selection dialog, where you can select a work layer, and turn layers on or 
off for display in your drawing. This function is also available from the Layer button, located in the lower 
left of the Giza Design 2004 screen. See the Status Bars chapter for more information on this dialog. 

Material Assignments  
When you select Material Assignments, the Material Assignments dialog box appears. From here you 
can set colors for or apply image textures to various surfaces. 

Drawing Toolbar 

 

Layer Setup 
This button brings up the Layer Selection dialog, where you can select a work layer, and turn layers on or 
off for display in your drawing. This function is also available from the Layer button, located in the lower 
left of the Giza Designer screen. 

Current Color 
To change the color, click the button. The Select Color dialog appears. Click the color you want, and click 
OK. If you wish to modify a color, double click it to bring up the Color to Modify dialog. 

Pen 
This dialog appears when you click the arrow next to the Pen box on the Lower Status Bar. Pens are used 
to display lines differently in the drawing. To change the current pen type, select a pen from the list and 
click OK. 

XY Forcing 
Check XY to enable XY Forcing in your drawing. This makes it so that all lines or walls you draw are 
forced to be at 90 degree angles to one another (in general, this is true vertical and horizontal). 

Rounding 
Turn the Ruler on to force placement of elements to conform to the increment set for the Ruler. This 
increment is set on the Input tab of the Options dialog, located on the Tools menu. The default Ruler 
increment is 1'-0". 

Work Angle 
Click the Work Angle button to bring up the Set Work Angle dialog, where you may control your drawing 
angle. 
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Furniture Toolbar 

 

Snapping 
If this box is checked, the symbols you place are snapped to the nearest existing item in the drawing 
when clicking with the left button. If Snapping is not checked, furniture items you place are rounded, but 
not snapped to existing items except when right-clicking. 

3D 
The status bar placement options help you determine how symbols are placed in the Z plane. Click the 
button next to a placement mode to select it. 
Norm. Used for placing symbols on the floor of your model (without a Z Height). If default library 
elevation settings are in place for specific furniture items, they are placed with these defaults rather 
than on the floor. 
 
Surf Use the 3D surface placement mode when you wish to place symbols on top of one another: for 
example, when you are placing desktop items. If you try to place a phone on top of a desk without first 
selecting 3D Surface, the phone is placed on the floor instead of on the desk. You may also set a specific 
Z Height, but 3D Surface is useful because you need not know the exact height of the desk to place a 
phone on it. 
 
ZHt Use the Z Height mode to set symbols a specific distance above the floor of your model. Use the 
arrows to the right of the box to change the value, or enter a value directly. 
When you are finished placing symbols with Z height, remember to return to Normal placement mode. 

Other icons concern installed databases or on CD-ROM. Please contact Support for more details. 

Walls Toolbar 

 

Height 
Enter the height for the walls in the box. You may enter the value directly or use the increment arrows. 
Any walls you draw are of the height entered here. 

Width 
Enter the width for the walls in the box. You may enter the value directly or use the increment arrows. 
Any walls you draw are of the width entered here. 
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Justification 
The justification set for the walls appears here. To change the wall justification, click the arrow button to 
bring up the Wall Justification dialog. You may also set justification on the Wall Parameters dialog, 
reached by clicking the green clipboard icon on the Walls Tab menu. 

Auto Snap 
Check this box to enable wall snapping. This mode snaps new walls to the closest existing wall, within 
the Auto Snap tolerance. This tolerance is set on the Wall Parameters dialog, which you may access by 
clicking the green clipboard icon on the Walls tab menu. 

Create 3D 
Check Create 3D to have walls drawn as 3D symbols in the 3D drawing window as each wall is drawn. 
Otherwise, walls appear as 2D lines. Walls can be remade, from 2D to 3D and vice versa, after they are 
established. 

Slope 
Check this box to enable wall slopes. This allows a wall to be placed with different end heights. Enter the 
other height in the End Ht box. 

End Ht 
Click End Ht to set the end height of the wall. Use the arrows, or enter a value directly. 

Customize Toolbars 

Toolbars in Giza Designers can be turned on and off. You may also rearrange them to meet your 
personal preferences. This dialog box allows you to manipulate the toolbars as well as reset them when 
necessary. You may also choose to turn off or turn on specific buttons on the Standard, View, & Tools 
toolbar. 

1. Click Tools/Customize Toolbar. 

2. In the Customize Toolbar dialog box, select the toolbar functions to appear on the 
toolbar by placing a checkmark next to the chosen function of that toolbar. 
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3. To remove icons for functions not frequently used, Click on the tab that represents 

that toolbars function and remove the check mark by clicking on it, scroll through 
the toolbar functions by clicking the direction arrows in the lower right of the dialog. 

4. Adjust the size of the icons by checking the Large Buttons check box. 

5. Click Exit. 
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Side Menus Overview 

The left side menus change depending on the tools you use. 
 

 
1. Click the Draw CAD button to see the Drawing menu side bar or Pick 2d CAD from 

the Draw pull down. 
 
Notice the Draw, Notes, Dimension, Symbols and Perimeter tabs. Each tab has 
different drawing tools. We will cover these tools later in this manual. 

2. Click the Draw Walls button to see the Walls menu side bar or click Walls from the 
Draw pull down. 
 
Notice the Walls, Openings and Dimension tabs. We will cover these tools later in 
this manual. 
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3. Click the Furniture Placement button to see the Furniture menu side bar. The 

default library is Generic. Other furniture libraries are available. 
 
Notice the tabs for each section of the library, the tabs will change depending on 
the library loaded. 

Draw Lines 

Use the Draw menu to drawing basics in Giza. 

1. Click the Draw CAD icon  to see the Drawing menu side bar or choose Draw, 2d 
CAD from the menu bar. 

2. Click the Draw Running Line icon  on the Draw tab. 

3. Pick a point in the drawing area. 
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4. Draw a star. 
 

 
5. To snap the lines together, right-click over the end of the first line. 

6. To stop drawing a line, click the Stop button or press the ESC key on your keyboard. 

7. Click the Single Line icon  on the Draw Tab. 

8. On the Drawing Toolbar check the XY box to draw a line using orthographic 
projection (on 0°, 90°, 180° and 270° angles) 
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9. Draw a line under the star. 
 

 

10. Use the Rectangle tool to draw a box around the star.  
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Edit – Delete/Copy/Move 

To access the editing tools, right-click on the object you want to edit. 

Select a Single Object 

1. Click on the rectangle you have drawn. Notice that it turns red. 

2. Right-click any highlighted item and choose a modification command from the Edit 
menu. 

Select Multiple 

1. To select multiple items for edition hold down the CTRL key on the keyboard and 
click each item. Each item you click on will be highlighted. If you select an item by 
error, hold down the CRTL key and click that item again to deselect it. 

2. Right-click any highlighted item and choose a modification command from the Edit 
menu. 

Select a Group 

1. To edit an area of adjacent items, place the cursor near the group of items to be 
deleted in the drawing window. 

2. Hold down the left mouse button and drag the cursor so a dotted line box 
encompasses the group of items to be selected. When you release the mouse, 
everything within the box or touching the box will be highlighted. 

3. Right-click any highlighted item and choose a modification command from the Edit 
menu. 
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Copy 

1. Select the line under the star. 

2. Right-click on the line. 
 

 
3. Click Copy, Copy. 

4. Pick two points on the screen. The copy command stays active if you want to 
continue copying the item you can keep picking locations. To stop either click the 
Stop button or press ESC on your keyboard. 

5. Another quick way to copy an item is to select it, hold the CTRL key on keyboard and 
drag the item to a new location.  To copy something exactly from one spot to 
another use the right-click function. 

6. Right-click on a line and click Move, Move. 

7. Pick two points to move the line. 

Note: Another quick way to move a line is to select it and drag it. 

Fillet 

1. Draw a single line perpendicular to a line. 

2. To select both lines, click in the drawing space and drag the mouse over both lines 
or select one line then select the other while holding your CTRL key down. 

3. Right-click on one line and select Fillet. 
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4. In the Fillet Radius dialog, leave the radius at 0 and click the Perform Edit button. 
 

 

View Commands 

 

To see different areas of the drawing you will need to use different view commands. 

1. To refresh the drawing window, click on the Redraw Window icon #1 

2. If the drawing extends beyond the size of the screen click the Zoom Allicon #2 

3. To view a specific area, click on the Zoom Area icon #3. Then click one corner of the 
area then click the opposite corner of the area to view. 

4. To enlarge the drawing, click the Zoom In icon #4 

5. To reduce the drawing, click the Zoom Out icon #5 
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Save Drawings 

1. Click this icon   or from choose File, Save from the menu bar. The Save Drawing 
or file dialog box opens. 
 

 
2. In the Save in field, note that the file is being saved in the CDB folder this path can 

be changed to the desired location. 

3. In the Save as type Field, note the type of file you are saving. In this example, you 
are saving a .cdb file. 

4. In the File name field, type in the name of your file. 

5. Click OK. 

Note: Catalog symbols are saved locally in the drawing to prevent symbols not showing up when a 
catalog is missing or changed. 
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Walls and Dimensions 
 Draw Walls 

 Running Walls 

 Interior Walls 

 Corner Editor 

 Modify Walls 

 Openings - Windows and Doors 

 Move Openings Using Slide 

 Move Openings Using 2-Point Slide 

 Place Openings at a Specific Distance 

 Snap/Set Reference 

 Measure Distance 

 Dimension Walls and Furniture 

 Modify Dimensions 

 Notes 

 Exercise 

Draw Walls 

Giza Designer and Professional allow you to generate 3D walls, windows, and doors. These walls allow 
you to generate the exterior shell of buildings or areas within buildings. Walls that are generated using 
the Draw > Wall tools consist of two lines that act as a unit in plan view. When generated in a 3D view 
these walls have thickness as well as height. Editing features allow existing walls to be moved and 
changed to represent changes to the floor plan. Windows, openings and doors can be added and placed 
in the structure. Draw > Walls also allows for floor plans to be dimensioned for placement of furniture 
and additional information. 
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1. From the Draw pull down, left click on Walls or the Walls icon. 

2. The Walls menu opens on the left side of the screen. 
 

 
3. From the Draw Walls Icon Menu, make sure that the Walls tab is selected. 

4. The top row of icons on the Walls Icon Menu is used to create walls. The top left 
icon draws continuous (or running) walls. The top right icon draws a single wall only. 

5. On the Drawing Tool Bar, usually located just above the left-hand icon menu, turn 
on XY and Ruler by left clicking in the white boxes in front of them. The XY forces the 
walls to draw orthogonally (straight right, left, up or down), and the ruler allows you 
to draw walls to an exact length. 
 

 
6. On the Walls Tool Bar, usually just to the right of the Drawing toolbar, you can 

change the wall settings such as height, width and justification. 
 

 
7. The Height and Width of the walls can be project specific. 
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8. Wall Justification determines how walls are created based on the dimensions that 
are given. 

 Right justification places a second line the width of the wall to the left if you were standing on the 
line being drawn. 

 Left justification places a second line the width of the wall to the right if you were standing on the 
line being drawn. 

 Center justification places a line half the width of the wall on either side of where you are standing. 

Running Walls 

1. Click on the Draw Running Walls icon on the Walls Icon menu. 
 

 
2. Choose a starting point at the bottom left hand side of the drawing window. 

3. Move the cursor up (one or two inches). A preview of your wall will appear. 

4. Hold the left mouse button until the Input dialog box appears. This allows for entry 
of an exact distance. 
 

 
 

Note: The Ruler   must be checked for Input to work correctly. 

5. Type in the length of the wall (or use the increment arrows: the left arrow is for 
feet, right is for inches), and left click OK. 
 
Note:  You can type in decimals or fractions. Be sure to use the foot (’) and inch (”) 
marks. If the distance is in feet you do not need to use the foot mark. Giza defaults 
to feet unless told otherwise. If using fractions, be sure to put a ‘space’ between the 
whole inch unit and the fraction. 

6. The cursor is still attached to the end of the first wall. Move the cursor to the right 
and again hold down the left mouse button to open the Input dialog. 
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7. Continue drawing walls in this manner until a room perimeter is complete. 

8. If you make a mistake, use the Undo button just to the right of the Stop sign to 
remove the wall. Left click on the Running Wall icon again and right click near the 
end of a wall to snap and reconnect the wall cursor. 
 
Note: If you right-click, you can "snap" items together. This means that they are 
touching or connected. This allows you to accurately place walls as well as furniture. 

Draw Walls on an Angle 

1. Choose the Running Wall button. 

2. Select a starting point near the center of your drawing area. 

3. On the Drawing toolbar, there is a compass to the right of the ruler check box. 
Select this icon and a dialog referencing a work angle is shown. 
 

 
 

Note: XY & Ruler  must be checked for work angle to work. 
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4. Change the Work Angle to 45, then click OK. 
 

 
5. Drag the mouse up and to the left and click and hold to enter a distance of 10’6”. 

The distance will be along the 45-degree angle. 
 
 
Note: This allows you to continue drawing walls at a consistent 90 degrees to each 
other but it is very important that this be used as a toggle to draw items at the 
appropriate angle. 

6. When done drawing angled walls, turn off the Work Angle icon. 
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Interior Walls 

Now that the exterior of the building is designed or drawn, specific interior walls need to be placed for 
the interior offices. 

1. Select Single Wall from the Walls icon menu. 

2. Choose the Point Input icon from the second row of toolbars. 
 

 
3. From the Point dialog box, determine where you would like to place the single wall. 

In this case we want a 12’-6” interior dimension to the offices that we are going to 
create. We want to go to the left so we need to verify that the arrow is pointing to 
the left and the value is entered in the white box on the left side of the arrow. The 
From Fixed Point box needs to be checked. This will allow us to indicate from what 
fixed point we want to affect the distance of 12’6”. When the values are entered left 
click on Enter Point. 
 

 
4. Bring your crosshairs to the inside corner of the bottom right hand side of your floor 

plan and right-click. This will click the exact point where the two walls join end to 
end. 

 
 
Note: If you need to use a different justification to place the wall correctly. Make 
the change to the Walls Tool Bar before beginning the wall command. 
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5. Your ruler will appear connected to the wall 12’ 6” from the corner. Pull the 
crosshairs up until the crosshairs are in-between the two lines of the top horizontal 
wall and click. 

6. Add a second horizontal wall that is 25’ from the bottom wall of the building using 
point input. 

Corner Editor 

To discuss corner editor, begin by drawing these four wall configurations. The dimensions of the walls 
are not important. 

 

Corner 

Using the corner editor, you can connect two non-intersecting walls to form a corner or you can take 
two walls that are crossing and create a clean corner connection. 

1. On the Walls icon menu under the section called Wizards, click the Corner Editor 
icon. 
 

 
2. At the bottom of the drawing window, in the status bar, will are asked to select the 

intersection of the walls you want to edit. Click on the right side of the horizontal 
line in configuration 1. The Visual Wall Corner Editor dialog appears with a graphic 
preview of the corner that has been selected. 
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3. Select Corner. In the graphic preview, a closed corner is represented by yellow lines. 

4. Click Apply. 
 

 

Fillet 

Using the corner editor, you can also round a corner to a chosen radius. 

1. Click the Corner Editor icon. 
 

 
2. Click on configuration 3, the corner to be curved. 

3. In the Visual Wall Corner Editor dialog, select Fillet (curve). 

4. Enter the radius of the curve. 
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5. Look at the preview in the dialog. 

6. Click Apply. 
 

 

Chamfer 

You can modify a corner by using a chamfer command. This will create a 45-degree angle at the 
apparent intersection of the corner. 

1. Click the Corner Editor icon. 

2. Click on configuration 4, the corner to be angled. 

3. In the Visual Wall Corner Editor dialog, select Chamfer (angle). 

4. Enter the interior length of the angled wall. 

5. Look at the preview in the dialog. 

6. Click Apply. 
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Modify Walls 

 Stretch Walls 

 Extend Walls 

 Join Walls 

 Trim Walls 

Stretch Walls 

The stretch feature allows you to lengthen/shorten an existing space. 

1. Click the Stretch Area icon. 
 

 
2. Select the wall area to stretch/shorten. To stretch an entire room, the end of the 

room must be selected. 

3. In the Stretch dialog box, enter an X or Y value. 

4. Click the directional arrow to ensure it is pointing in the correct direction. 

5. Click Perform Stretch. 
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Extend Walls 

1. Click the Trim/Extend icon. 
 

 
2. Click the wall to extend. 

3. Click on the end of the wall to extend. 
 

 
4. Use Cleanup if necessary. 

Join Walls 

Another way that two non intersecting walls can be joined is by using the Join Walls icon. 

1. Right-click on the radial corner and select Delete from the Edit menu. 

2. Click on the Join Walls at Corner icon. 
 

 
3. With the cursor, select the ends of the two walls you want to join as a corner. 
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Trim Walls 

1. Click the Trim/Extend icon. 
 

 
2. Click the wall that will be cut. 

3. Click on the wall to be trimmed off. 

4. Use Cleanup if necessary. Choose either an intersection or a single wall to close in 
any open walls. 

 

Openings - Windows and Doors 

Now that you have your floor plan, let’s begin to add doors and windows. 

1. To place openings on the perimeter of the room, make sure that the Walls icon 
menu is available. 

2. Click on the Openings tab on the left side of the screen. 
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3. Click the single door icon . 

4. To the right of the drawing toolbar, you can change the Height and Width for 
openings before placement. 
 

 
5. Move the opening along the wall where the opening will be placed. 

Notice the symbol rotates automatically depending on whether the wall is 
horizontal or vertical, and whether the cursor is inside or outside the perimeter. The 
keyboard arrow keys will change the swing of the door from left hinge to right hinge 
and back. 

6. Once the opening is properly oriented, click to place the opening on the wall. 
 

 

Move Openings Using Slide 

After placing an opening (door or window), you can move it as follows: 

1. Right-click on the opening to access the Edit menu. 

2. Click on Slide. 

3. As you move the mouse, notice the dimension lines appearing on screen. The 
dimensions indicate the measurement from the corner to the center of the opening. 

4. Click to place the door at its new location. 
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Note: To place a 3’ door so that it will begin 3’ from the bottom left hand corner, you must measure 4’-
6”. The slide command moves the opening from its center line so in order to place it 3’ from the corner 
half of the width of the door needs to be added in the slide. 

Move Openings Using 2-Point Slide 

You can use 2-point slide to place an opening relative to the corner of a room or any portion of the wall. 

1. Right-click the opening to access the Edit menu. 

2. Choose Slide, 2 Point. 

3. The status bar asks for the reference point move. Move the pointer to the opening 
be used as a measurement point, for example, edge doorjamb. 

4. Right-click to set the point exactly on the corner. 

5. The status bar asks for the reference point for the slide. Move to the point that will 
be moved from. For example, an interior corner of the room. 

6. Move the pointer along the wall. Notice, the dimension showing on the screen. 
When the opening is at the correct position, click to move the opening, or you can 
type in the slide dimension in the dimension box in the bottom right hand corner of 
the screen. 
 

 
Note:  In our example, place the door at 6" from the bottom left hand corner. You can also use the Move 
Dialog command to move the door a specific distance. 

Place Openings at a Specific Distance 

Openings can be placed at the desired distance when placing from the Walls icon menu. 

1. Select a single swing door from the Walls Icon menu. This door is to be placed at the 
entrance to one of the offices. Use the Up and Down keys on your keyboard to 
change the swing. 

2. Choose the Point Input button. Place the edge of the door 6" from the corner. The 
cross hairs are at the center line of the 3' door. In order for the door to be 6" from 
the inside corner of the office there must be 2'0" to the center line of the door. In 
the dialog enter 2'0" in the Y direction box and choose the appropriate arrow 
direction. Click on the Enter Point button. 
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Right-click on the inside corner of the room. 
 

 
3. If the door swings the wrong direction or the hinge is on the wrong side, right-click 

on the door and choose either Reverse Hinge or Reverse Swing. 

Snap/Set Reference 

For more advanced placement of doors and windows use the Snap/Set Reference tool box. 

1. To place a window in the center of a wall. Select the window from the Walls Menu. 

2. Click the Snap/Set Reference button. 
 

 
3. Use Snap to Halfway to find the center of the wall. Right-click on either end of the 

wall you want the window centered in. 
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Measure Distance 

Measure Distance allows you to accurately measure the distance between two objects in your drawing. 

1. Click the Measure Distance icon . 

2. Right-click on the starting point of your measurement in the drawing window. This 
allows you to get a precise measurement by snapping to an exact point. 
 
Notice that a line forms from the original point of placement to the cursor. If you 
have the Ruler box checked, a dimension will be shown in real-time as you move the 
cursor. 

3. Right-click on the second “snap” point in the drawing. A dialog box will appear giving 
you the exact measurement between the two points. The length, distance, 
elevation, and angle will be shown. 
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Dimension Walls and Furniture 

1. To access the Dimensions side menu, click the Draw menu and select 2D CAD or the 

Draw CAD icon . 

2. Click the Dimensions tab on the side menu. 
 

 
See: 

 Standard Dimensions 

 Dimension Walls 

 Running Dimensions 

Standard Dimensions 

Standard dimensions can be placed for walls or portions of drawings. The actual dimension line can be 
placed anywhere on the drawing. 

1. Click the Standard Dimension icon. 
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2. Bring the cursor to the drawing screen and right-click at the point to begin the 
dimension. (Right-click snaps to an end point. This provides for accurate 
dimensions.) 

3. Bring the cursor to the point in the drawing where the dimension will end. 

4. Right-click to end the selection. The dimension line attaches to the cursor. Move the 
cursor to an area in the drawing where you want the dimension line to appear and 
click to place it. 
 

 
Note: Right-clicking grabs onto the end of lines, whether it is panels or walls. 

Dimension Walls 

This feature allows you to make sure the walls are drawn to the correct dimensions. To dimension walls, 
the line drawn by the dimensioning tool must cross at least two walls. 

1. Click on the Dimension tab of the side menu. 

2. Click the Dimension Wall icon. 
 

 
3. Bring the cursor to the drawing and click outside of the left wall. 
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4. Bring the cursor past the opposite wall. Click to end the dimension string. 
 

 
Note:  These dimensions cannot be moved easily but do not have extension lines and can easily be 
moved out of line. These dimensions are best for verifying room dimensions then to remove and 
manually place other dimensions in a more appropriate location. 

Running Dimension 

Running Dimension allows for a continuous string of dimensions to be connected in a straight line. 

1. Click the Running Dimensions icon. 
 

 
2. Bring the cursor to the drawing and right-click at the point to begin the dimension. 

3. Bring the cursor to the point in the drawing where the dimension will end. Right-
click again. 
 
Note: The dimension line attaches to the cursor. Move the cursor to an area in the 
drawing where you want the dimension to appear and left click to place it. You must 
work right to left or left to right. 

4. The Dimension Command is still active. To continue placing the running dimension 
lines, move the cursor to the next point to be dimensioned on that string and right-
click. This will calculate the dimension and place the dimension line aligned with the 
first one. 

5. Continue to move the cursor and right-click to add dimensions. 

6. To begin a new dimension string or end the running dimension command click on 
Stop. 
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7. If you would like to begin a new dimension string, click on the Running Dimension 
icon again. 
 

 

Modify Dimensions 

 Witness Line (Cut Dimension) 

 Join 

Witness Line (Cut Dimension) 

This allows an overall dimension to be broken into smaller sections. 

1. Click the Witness Line icon. 
 

 
2. Click the dimension to be cut. 

3. Click at the point on the wall where the revised dimension will be placed. 
 

 



 

48 

Join 

Join allows for individual sections of an overall dimension string to be merged together and create one 
larger dimension. 

1. Click the Join icon. 
 

 
2. Click the first dimension to be joined. 

3. Click the second dimension to be joined. 
 

 

Notes 

There are various types of notes in Giza Designer: 

 Single Line Text 

 Multi-line Text 

 Title and Scale 

 Leader Note 

To access the Notes tab, choose Draw, 2D CAD from the menu bar, then click the Notes tab in the side 
menu. 
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Single Line Text 

1. Click the Add Text icon. 
 

. 

2. Below the toolbars, set the Size - this depends on the size of your drawing. 

3. Click in the drawing screen where the text will be placed. Notice that you can rotate 
the text box attached to the cursor to change the orientation of the text using the 
arrow keys. 

4. Type the desired text (it appears on screen). 

5. When you are done typing, press the Enter key. 

6. To edit a single line text that has been placed, right-click on the text. 

7. In the Edit menu, choose Edit Paragraph. 

8. Make any adjustments and left click Replace. 
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Multi-line Text 

1. Click the Multiple Lines icon. 
 

 
 
The Multi-line Text dialog box opens. 
 

 
2. In the large white box, type in the text you want to place. 

3. Click Place Text. 

4. Click in the drawing screen where the text should be placed. 
 
Note: The text can be rotated using the arrow keys on the keyboard, before 
placement. 

5. To edit multi-line text, right click on the text. 
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6. In the Edit menu, choose Edit Paragraph. 
 

 
7. Adjust the text including justification and size. 

8. To replace the text exactly where it already is, click Replace. 

9. If you want to replace and reposition the text, click Place W/Cursor. 

10. In the drawing area, click where the text should appear. 

Title and Scale 

1. Click the Title and Scale icon. 
 

 
2. The scale factor defaults to 1/4", however, you can replace it with whatever you 

want. 
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3. Click OK. 

4. Click to place the text on the drawing. 

Note:  You can rotate the text using the up and down keyboard arrow keys. 

Leader Note 

1. Click the Note icon. 
 

 
 
The Multi-line Text dialog opens. 
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2. Type in the text you want to place, then click OK. 

3. Click in the drawing screen where the point of the arrow should be placed. 

4. Move the cursor to where the text should be placed and click to set. 
 

 

Exercise - Draw Walls 

Draw the floor plan below using the tools learned in the previous topics. 
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Furniture 
Once a building shell is drawn you can add furniture. In this exercise, you will place Generic furniture 
using different automation tools. When you use your individual manufacturer symbols, the tools and 
dialog boxes vary to accommodate that particular line. We will cover the following tasks and furniture-
related topics: 

 Select a Furniture Library 

 Freestanding Furniture 

 Panels 

 Worksurfaces 

 Pedestals 

 Chairs 

 Place Furniture at Specific Angles 

 Change the Height of a Symbol 

 Search by Exact Part Number 
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 Search by Partial Part Number 

 Move or Copy an Item 

 Move Multiple Items 

 Move to a Measured Distance 

 2 Point Move 

 Copy Multiple Items 

 Mirror 

 Move Rotate 

 Copy Rotate 

 Align 

 Specialized Symbol Placement 

 Grids 

 Place Symbols at a Specific Location 

 Typicals 

 Tags 

 Select Items 

 Select Items by Sub-Layer 

 Select Items by Attribute 

 Layers 

 Existing and New Furniture Using Pen Override 

 Masks 

 Renderings 

 Presentation Extras 

 Material Assignments 

 Bill of Materials (BOM) 

 Print 

 Vignette Plot 

 Logo 
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 Templates 

 Raster Background 

 AutoCAD 

 Set Drawing Options 

Select a Furniture Library 

1. Select Draw from the pull down menu and then select Furniture. 

2. Click the Library Title Bar drop-down from the furniture sidebar menu and select 
Browse. 
 

 
 
In the list on the left, you will see all of the installed manufacturers. Once the 
manufacturer is selected, you will see the product lines for the selected 
manufacturer to the right. 

3. On the left, select the Generic manufacturer. 
 

 
4. On the right, you will notice two choices, Icon and Sidebar. Choose Sidebar and click 

OK. The Icon menus displayed allows you to select products based on the pictures of 
the items selected. 
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Sidebar Menu 

This is a File/Folder menu. You will see the main folders, Panels, Worksurfaces, System Furniture, etc. 
 

 
1. Left-click on a main folder, the sub-folders for that selection will appear. 

2. Continue to click, making the appropriate selections for that part. 

3. When a list of part numbers appear in the bottom screen, click once on the part you 
wish to select, this will attach the symbol to your cursor. 

The Firecracker icon  opens all folders. 

The Vacuum Cleaner icon  closes all folders. 

The Blue F icon  allows you to change the font of the library text. 

The Arrow icon  brings you up one folder level. 
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Icon Menu 

1. In this icon menu, you will see tabs for the divisions of furniture, Panels, 
Worksurfaces, System Furniture, etc. 
 

 
2. Click a tab to select the division you want to use. 

3. Click the icon to select the furniture type. 

4. The furniture matrix opens and allows you to select the exact symbol you want to 
place. 

5. Click on the dot that indicates the proper symbol. The furniture symbol is now 
attached to your cursor. 
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Freestanding Furniture 
Now it is time to turn off the X, Y forcing and the Ruler by removing the check marks at the top of the 
drawing window. This is necessary when you place furniture because x,y forcing only allows furniture to be 
placed in line with the first symbol placed. 

1. Select the correct product line 

2. Click to choose sections of the catalog. 

3. When you are at the product level, click on the symbol you would like to place, the 
symbol should now be on your crosshairs. 
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4. To rotate an object you can use the arrow keys. Right and left arrows spin the 
furniture 11.25° at a time. The up and down moves 90° at a time. 
The right and left arrow key rotation increment of 11.25° can be changed in the 
Options Dialog box. Found under the Tools pull down. 
 

 
5. Place the object with a click at the starting location in the drawing window. 

Panels 

1. From the Furniture icon menu, make sure that the icon library is selected. 

2. Click the Panels tab. Make sure that Complete panel is selected from the drop-down 
menu on the panels tab. 
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3. Click the icon marked Fabric. 
 

 
4. Click the box representing a 24/48 panel from the furniture matrix. 
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Change the Panel Orientation 

1. Using the arrow keys on the keyboard, rotate the panel until it is in a horizontal 
orientation. The Up and Down arrow keys spin the panel 90° until the Left and Right 
arrow keys spin the panel 11.25° at a time. 

2. Position the cursor in the drawing area where you want to place it and click once. 
 

 
Note:  To attach a panel to the end of another panel right-click when you have the panel you are placing 
near the first one. 

Panel Placer 

1. In the Furniture Matrix, select the 36/62 panel. 

2. Click the Panel Placer icon . This displays the Panel Placement dialog. 
 

 
 
Note: Notice that the orientation of the diagram in the center of the dialog is the 
same as the last panel that you placed. 

3. The darker arrows indicate where you can place the next panel relative to the first 
panel. Click the far left up arrow to snap a vertically positioned panel attached to 
the first panel. 
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4. Select and place the following panels: (2) 42 x 62 to create a 90 degree corner; (3) 
30x62 to the right, (2) 42x62 to form a 90 degree corner, (1) 36 x 62 going down, (1) 
24 x 48 to the left. 

5. If you make an error, click the Undo button in the Panel Placement dialog - NOT the 
Undo icon on the toolbar. 

See Sample Panel Layout 

Sample Panel Layout 

  

Change the Panel Reference 

1. If you need to change the panel you are working with, click the Set Ref button. 

2. Place the cursor on the panel you need to reference in the drawing and click once. 
The panel you just clicked on is now highlighted. This is a visual aid letting you know 
when you place the next panel using the dialog direction arrows, it will snap to the 
highlighted panel. The Ref. Last button will automatically highlight the last panel 
placed in the project. 

3. Using the panel system you just completed, open the Panel Placement dialog. 

4. Click the Set Ref. button. 

5. Bring the cursor over the upper right vertical 42 x 62 panel. 
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6. Click once to highlight the panel and set that panel as the referenced panel. 
 

 
7. Click the upper right arrow to place a panel making a 3-way connection. Notice the 

spacing is correct for a 3-way connector. 

Worksurfaces 

When placing worksurfaces, the cross hair will be on the back corner of the worksurface. Be sure that 
the back of the worksurface is attaching to the panel.   

1. Click the WkSurfaces tab on the Furniture Icon Menu, then select w/o KB (without 
keyboard). 
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2. Select a 36x24 rectangular worksurface. 
 

 
3. Bring the cursor into the drawing area. An outline of the worksurface is attached to 

the cursor. 

4. Use the arrow keys on the keyboard to rotate the worksurface. 
 
Note: If the symbol will not rotate, select it again from the menu. 

5. Bring the worksurface close to, but not touching, the corner created by the panels in 
the lower left. 

6. Right-click to snap it to the panels. If you have the symbol too close to the panels, it 
may snap to the wrong side of a panel. Make sure you place the worksurface 
correctly before continuing. 

7. Continue placing additional worksurfaces in the same manner, with a 42” corner 
worksurface in each corner and a 30 x 72 peninsula attached to the 30” panel as 
shown below.
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Overhead Storage 

When placing overheads you need to investigate each product line as each manufacture inserts the 
overhead at different elevations. Generally the insertion point for the overheads is at the top left corner 
of the back of the cabinet. The following steps set your drawing up to place the overheads at the 
appropriate location. 

1. On the Furniture Icon Menu, click the System Furn Tab, then click the FD Cab icon. 
 

 
2. Select the 13” X 36” flipper. 

 

 
3. To place the overhead cabinet at the proper height, select Z Ht to set the furniture 

elevation Z-height . 
 

 
4. To the right of Z Ht type in or use the increment arrows to enter the desired Z-

height. In this example, the panel is 62” high. Therefore, set the Z-height to 62” (or 
5’ 2”). 

5. Bring the flipper directly over the 36” straight worksurface along the left side. 

6. Right-click once to snap it into place. Place the same flipper above the other 36” 
straight worksurface. 
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7. On the toolbar, click the Activate 3D Window icon  to see that the flipper has 
placed at the proper height. 

8. Click on the Create Hidden Line icon  to hide lines. 

 

9. Click the Activate 2D Window icon  to return to the 2D view. 

Note: Be sure to change the Z Ht back to Norm after inserting overheads, otherwise any items that you 
place after making this change will come in 62” above the floor. 

Pedestals 

1. In the System Furniture tab, click on the Ped (pedestal) icon. 
 

 
2. From the furniture matrix, select a 20”, box, box, file pedestal (BBF). 

 
Note: The cursor is attached to the front of the pedestal. This gives you the ability to 
snap the front of the pedestal to the front edge of the work surface. 

3. Bring the pedestal to the 30”x24” worksurface located to the left of the peninsula. 
Move it onto position about where it should be installed. 

4. Right-click to snap the pedestal into place. 

5. Place three more pedestals: one under the opposite 30”x24” worksurface, and one 
under each 36”x24” worksurface. 
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Chairs 

1. Click on this button to display the Seating tabs. 
 

 
2. Click on the Seating tab, then on the Chairs icon. 

 

 
3. From the furniture matrix, click on the Exec chair. Notice that the cursor is in the 

middle of the chair. 
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4. Use the keyboard’s left and right arrow keys to rotate the front of the chair parallel 
to the front edge of the corner worksurface. 

5. Click to place the chair. 
 

 

Place Furniture at Specific Angles 
With the Work Angle command used earlier to draw walls, furniture can also be placed at angles: 

1. Click the Work Angle icon . 

2. In the Work Angle dialog, enter the angle in the Work Angle field. 
 

 

3. If the angle is unknown, click the Select an element icon . 

4. Click on the angled wall to calculate the angle. The angle is automatically entered in 
the Work Angle field. 

5. Check Use Work Angle and click OK. 

6. Choose a furniture symbol. Note it is set to the same angle as the wall that was 
clicked. The symbol will also rotate at this angle 

7. Place the symbol as normal. 

8. When done placing symbols at this angle, click the Work Angle icon to stop the 
command. 
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Change the Height of a Symbol 

In this example, we will lower the 36” worksurfaces from the preset height of 29” to a typing height of 
27”. 

1. Right-click on the symbol. 

2. Hold down the CTRL key and click on each of the worksurfaces so they are all 
highlighted. 

3. Right-click on any red line, then choose Elevate from the edit menu. 

4. The Input dialog box opens. 
 

 
5. To move the symbols up, enter positive numbers or use the Up increment arrows. 

Worksurfaces will insert at standard worksurface height and must be moved in 
relationship to their default insertion point. To lower the symbols enter negative 
numbers or use the Down increment arrows. 
 
Enter -2” in the New Z-height field and click OK. 
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Search by Exact Part Number 

The select symbol feature allows you to find and place products based on their complete part number if 
they are in the current library. 

1. Click the Select Symbols icon . 

2. Enter the exact part number in the Style/Part Number field. 
 

 
 
Once the product is located, a graphic preview will be shown. 

3. Click on the Place button and the item will be on the crosshairs in the drawing 
window. 
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Search by Partial Part Number 

The select symbol feature allows you to find and place products based on their partial part number or 
description. 

1. Click the Select Symbols icon . 

2. In the Place by Part Number dialog click the More button.   
 

 
3. In the following dialog box, enter the partial part number or description to search 

and type an asterisk (*). 
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4. Beside Field, choose whether to search by Part No. or Desc.. 

5. Under the search results window you see Product Lines to Search/List. Choose 
Current Manufacturer, the Loaded manufacturers, or All to search all installed 
libraries. 

6. Click the Search button. 
 
A list of all product codes that begin with letters/numbers entered appears in the 
bottom window. 

7. Click on the part number to be placed, then click the Place button to place the 
symbol in the drawing. 

Move or Copy an Item 

1. Click and hold the left mouse button on the symbol to move. 

2. Drag it to the required location and release the mouse button. 

OR 

1. Right-click on the symbol to move. 

2. From the menu, choose Move, Move or Copy, Copy. The Symbol will be picked up by 
crosshairs. 

3. Move the symbol to the required location and click to set. 

Move Multiple Items 

1. Select the symbols to move. 

2. Click and hold the left mouse button on one of the highlighted symbols. 

3. Drag the mouse to the required location and release the mouse button. 
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Move to a Measured Distance 

1. Select the symbols to move. 

2. Right-click on one of the highlighted lines and choose Move, Move (Dialog). 
 

 
 
The X setting is where you enter the distance you want to move left or right. The Y 
setting is where you enter the distance to move up or down. 
You can enter both an X and a Y distance. 
 
Use the directional arrows to the right of the fields to change the direction. 

3. Click Perform Move after entering the distance to move and or using the direction 
arrows. 
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2 Point Move 

2 Point Move allows you to move objects to a specific distance from a reference point. 

1. Select the symbols to move. 

2. Right-click on any highlighted item, choose Move, Move (Dialog). 
 

 
3. Enter an X distance and/or Y distance for the move. 

4. Verify that the directional arrows are pointing in the right direction. 

5. Check 2 Point Move. 

6. Click on Perform Move. 

7. Select a reference point. You can right-click on a point and the objects will move the 
specified distance from the point you select. 
 
Note: If you don't type an X or Y distance you will be prompted for a reference point 
and a new location. You can also change the rotation at that time. 
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Copy Multiple Items 

1. Select the symbols to copy. 

2. Right-click on one of the highlighted symbols and select Copy, Copy. 
 

 
3. Select a Reference Point for Duplicate. 

4. Place the center of the crosshair cursor at the back of the left corner worksurface 
and right-click to set the reference. This tells the program you want to snap the 
corner worksurface to another point in the drawing. 
 

 
5. Move the cursor to the far right side of the workstation, so the corner of the 

worksurface is near the panel that the corner worksurface would hang on and Right-
click to snap. 

6. When this dialog box appears, click Delete Overlapping Panels. 
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Mirror 

Mirror allows workstations to be placed back to back without duplicating panels. If a symbols is 
“handed” the software will automatically update the symbol with correct part number. 

 Mirror X 

 Mirror Y 

 Move Rotate 

Mirror X 

1. Select the symbols to mirror. 

2. Right-click on one of the highlighted symbols and select Mirror, Mirror X. 

 
3. Select a Reference Point for Mirror Copy. 

4. Click on the left side of a vertical panel to select the first reference point. 

5. Click on the point that is on the opposite side of the vertical panel when the status 
bar displays New location for reference point. Essentially are making a mirrored 
copy of your worksurface and flipping it over the panel that you are choosing. 
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6. Click on Delete Overlapping Panel(s). 

 

 

Mirror Y 

1. Select the symbols to mirror. 

2. Right-click on the selected furniture and choose Mirror, Mirror Y. 
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3. Select the first reference point (see below). 

4. Select the  New location for reference point on the opposite side of the vertical 
panel. Essentially you are making a mirrored copy of your worksurface and flipping it 
over the panel that you are choosing. 
 

 
5. Click Delete Overlapping Panels, this dialog appears. 
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Move Rotate 

Use this command to rotate or to rotate and move the symbol(s) at the same time: 

1. Select the symbols to move and rotate. 

2. Right-click on one of the selected symbols and choose Move, Move/Rotate. 

3. Enter the degree and direction for rotation in the Rotate dialog. 
 

 
4. Click Perform Edit. 

5. Right-click at exact point on the selected symbol(s) to be referenced as the axis (the 
point the symbol(s) will rotate around). 
 
To rotate only - right-click again at the same spot. 
 
To move and rotate - move the cursor to the exact point on screen to move to (the 
first point selected will move to this point). Right-click again to snap to an existing 
symbol, or click once to move without snapping. 
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Copy Rotate 

This function is performed the same as the Move Rotate, the only difference being the name of the 
command chosen from the Edit menu. 

Align 

The Align feature automatically aligns selected symbols with one click of the mouse. For example, a row 
of chairs or desks can quickly be aligned by the front, rear, center or sides of the symbols. 

1. Select the symbols to align. 

2. Right-click on one of the selected chairs and choose Utilities, Align. 

3. In the Align Elements dialog, click on the alignment to be used. 
 

 
Note:  Multiple rows of items that are selected for alignment will be aligned to the same point. Align is 
best used for single items to be aligned rather than workstations. 

Specialized Symbol Placement 

The program allows you to place symbols, typicals and columns in grid patterns. This is helpful when 
setting up a large seating arrangement or a classroom setting. 



 

82 

Grids 

Single Symbol Placement 

1. Select the symbol to be placed. 

2. From the menu bar choose Draw, Symbol Placement, Grid. 

3. Place the first symbol as usual. 

4. To place subsequent symbols, click the Point Input icon  and enter the 
appropriate X and/or Y values. . For example, if you placed a chair and want to place 
each chair with a 1’ space between them and the chair is 2’ wide, enter an X value of 
3’. 
 

 
5. Make sure that the directional arrow is pointing in the proper direction. 

6. Check From Fixed Point and click Enter Point. 

7. Right-click at a point on the symbol that is already placed, in this case the insertion 
point of the chair. 

 
8. In the Input dialog, enter the number of chairs to be placed per row and click OK. 
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9. Now the program needs to know where to place the second row. Again, use the 
Point Input and enter a Y value (ensure the directional arrow is pointing correctly - 
up or down). 

 
10. Click Enter Point. 

11. Right-click at a point on the symbol that is already placed, in this case the insertion 
point of the chair. 

12. In the Input dialog, enter the number of rows to be placed and click OK. 
 

 
Note:  Another way to perform this routine is to use the formula X, Y. Rather than using the Point dialog, 
simply place the first piece of furniture in the grid and type in the X (left or right) or Y (up or down) 
coordinates. X comes before the coma, and Y after. Remember to include width of each piece as you are 
measuring from center point to center point. 
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Place Symbols at a Specific Location 

1. To place a symbol at a specific location, first choose the symbol to be placed. In this 
example, our desk will be placed 4” to the right and 4” down from the upper left-
hand corner of the main room. 
 
Because the Origin Point of the typical is on the interior of the upper left corner, this 
will leave 2” of space between the typical and the wall. 

2. Select a desk from the furniture menu 

3. Click the Point Input icon . 

4. Enter 4” in the X field and make sure the arrow is pointing to the right. 

5. Enter 4” in the Y field and make sure the arrow is pointing down. 
 

 
6. Check From Fixed Point and click Enter Point. 

7. Move the crosshair cursor just inside the upper left corner and right-click to place 
the typical. The desk is now placed 4” from the corner of the room. 

Typicals 

 Create Typicals 

 Place Typicals 

 Place Typicals on a Grid 
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Create Typicals 

Rather than recreating this configuration from scratch every time it is needed in a project, Giza can save 
it as a typical, which can then easily be reused and placed in many different drawings. To do this: 

1. Select the entire workstation, including the panels. 

2. Right-click on one of the highlighted symbols and choose Utilities, Make Typical. 
 

 
3. In the Make Typical dialog, assign a name to the typical in the File field. 

4. Under Make Typical From, choose Selected Elements. 
 

 
5. The next step is to set an Origin Point. The Origin Point is the point in the typical 

where the cursor will be attached. This provides a visual reference when you place 
the typical. 
 
Under Origin,select Choose Point. 

6. Click this icon   to the right of Choose Point. 

7. Move the center of the crosshairs cursor inside the panels in the upper left corner. 
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8. Right-click to set the Origin Point. 

9. In the Save Typical dialog box click Save. 

Note: When choosing the origin point for a typical it is important to consider how these typicals will be 
connecting to each other. The point selected should be at the corner of a worksurface where it attaches to a 
panel, usually a panel that will act as a spine wall. 

Place Typicals 

1. To place a saved typical choose Draw, Typical from the menu bar. The Place 
Typical dialog appears. 
 

 
 
Note: The name of the last typical that you saved appears in the dialog. Click the 
Browse button to find other typicals. 

2. Click on the Place button. An outline of the typical appears, which is attached to the 
point you set as the Origin Point. To rotate the typical, use the arrow keys on the 
keyboard. The large X at the bottom left of the typical is a visual aid to help when 
you rotate the typical. 

3. Position the typical on screen where you want to place it then click to set it in the 
drawing. 

4. To snap the typical to an existing symbol, place the cursor near that point and right-
click. If you make a mistake, click the Undo icon to erase the typical and try again. 
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Note: The cursor is the only active snapping point in the typical before you place it. 
Once placed, all the snapping points become active. 

5. If there are any overlapping panels, the Highlighted Overlapping Panel(s) dialog 
appears. If you click Delete Overlapping Panels, any duplicate, overlapped panels 
will be removed. 
 

 
  



 

88 

Place Typicals on a Grid 

1. To place a typical on a grid choose Draw, Typical from the menu bar. The Place 
Typical dialog box appears. 
 

 
2. Choose Grid and click Place. 

3. Snap the next Typical by right-clicking to the outside panel. 
 

 
The Input dialog pops up. 

 
4. Enter the number of typicals you need in the row and click OK. 

5. When you are asked to place the typical again for the next row placement, if you 
only want one row click Stop or press ESC. 
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To place the next row, use the Point Input tool. Add the width of the typical to the 
aisle size for your Y distance. 

 
6. Select From Fixed Point and Enter Point. 

7. Right-click the insertion point of the first typical. 

8. Enter the number of rows you want and click OK. 

 
9. If there are any overlapping panels, the Highlighted Overlapping Panel(s) dialog 

appears. 
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If you click Delete Overlapping Panels, any duplicate, overlapped panels will be 
removed. 

Tags 

To further define the parts within your drawing for the Bill of Materials report, or Worksheet, tags can 
be added, these can also be used for selection sets. This can be useful if you need to separate the 
drawing into areas for phasing or Department. 

1. Right-click on an item and select Change, Tag. 
 

 
2. Click the Down Arrow to see more fields. 

 

 
3. In the Department field, type Sales and click OK. The tags will appear in the Bill of 

Materials. These can be placed using selection sets as well. 
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Select Items 

There are various ways to select symbols and/or walls in Giza. 

From the menu bar choose Edit, Select and choose one of the following: 

 All to select the entire drawing 

 By Attribute to select symbols by various attributes such as part number, frame design name, tags, 
etc. 

 By Part No. to select by part number. A list of all the part numbers in the current drawing appears. 
Click on the part number to be selected.  
Note: You can select multiple part numbers by clicking the different part numbers. 

 Restore Last to restore the last selection set used (you can also right-click on a blank area of the 
drawing screen and choose Restore Last) 

 Invert to deselect symbols and automatically select symbols that were not selected in the previous 
selection set. For example, if you had two workstations and selected one of them, you would then 
choose Edit/Select/Invert to select the other workstation. 

Select Items by Sub-Layer 

1. From the menu bar choose Edit, Selection Set. The Selection Set dialog box appears. 
 

 
2. Select the Sub-Layer of the items that you want to work with in your drawing. For 

example, select gn-panel. 
 
- To add all items in the drawing to the selection set, click on All under Add to 
Selection Set. 
- If only the panels from a portion of the drawing should be added, click Area and 



 

92 

select the desired area. 
- Select Single to select each panel. It will not allow you to add anything to the 
selection set that does not meet the criteria specified above. 

3. To remove items from a selection set, utilize the same criteria as above but use the 
Remove from Selection Set area. 

The following figure demonstrates all of the panels being included in a selection set. 
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Select Items by Attribute 

1. From the menu bar choose Edit, Selection Set. The Selection Set dialog appears. 
 

 
2. Click the drop-down arrow beside Filter and select By Attribute. 

3. In the Attribute field, select the attribute of the items that you want to work with in 
your drawing. For example, select Department. 

4. Beside Pattern, you can either select all items by entering an asterisk * or enter the 
data, in this case “Sales”. 

5. To add all items in the drawing to the selection set, click on All under Add to 
Selection Set. 
 
If only the panels from a portion of the drawing should be added click Area and 
select the desired area. 
 
Select Single if you want to select each panel. It will not allow you to add anything 
to the selection set that does not meet the criteria specified above. 
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Note:  To remove items from a selection set, use the same criteria as above but use the Remove From 
Selection Set section. 

Layers 

2020 Giza allows you to organize your drawing into multiple overlapping layers. The use of layers makes 
it easy to control the display and printing of elements, and can help prevent accidental modification. 
When you turn a layer On, the layer displays in your drawing. If you turn a layer Off, it does not appear 
in your drawing. This allows you to view different aspects of your drawing without certain elements. If 
you set a layer to Background, it appears in your drawing, but may not be edited, and Search allows a 
layer to appear in the drawing and in searches, but not for editing. 

1. Click on main in the Drawing toolbar to access the Layer Setup dialog box. 
 

 
2. Click on main under Layer Selection. 
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3. To turn off all the layers except the panels click the Off button. This turns off all the 
selected sub-layers. 
 

 
4. Click on the gn-panel sub-layer to highlight that layer only. 

5. Click the On button to turn that single sub-layer on. 

6. Click OK. 

Note: To turn the layers back on, follow the first steps above, but click the On button instead of the Off 
button. 

  



 

96 

Display Mode 

The display area on the left of the Layer Setup dialog shows all the layers in the drawing, and highlights 
the sub-layers of the layer currently selected on the right. These sub-layers are automatically created 
when items are placed in the layer. For instance, if you have drawn walls and placed a panel with main 
selected as your work layer, these appear as sub-layers. If you are using the Generic furniture library, for 
example, the panel appears as gn-panel. 

The blue boxes beside each layer are checked whenever layers are selected, and read On, Off, Search or 
Back, depending on the option selected. The default is On. To change the display mode of a layer, 
highlight it, and click the button of the desired display mode. 
 

 
 On - Turns the selected layers or sub-layers on for search, edit and display. 

 Off - Turns the selected layers or sub-layers off for search, edit and display. 

 Search - Turns the selected layers or sub-layers on for search and display, but not edit. 

 Back -Turns the selected layers or sub-layers on for background display only. They are not available 
for searches or edits. 

 Delete - Removes a sub-layer from the drawing. This does not remove the layer itself. To remove a 
layer, use delete from the Selection section of this dialog. 

 Override - Overrides the pen or color of a sub-layer. 

Note:  It is a good idea to go into layers and turn the walls layer to Search before starting to place 
furniture. This allows you to edit the furniture without accidentally moving a wall. Follow the steps 
above, but click Search rather than Off. The walls will still show on screen. 
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Existing and New Furniture Using Pen Override 

In this example, we will create a drawing for an existing customer who is expanding and adding new 
workstations to their current configuration. This example covers adding a layer named “existing”, using 
pen override and moving symbols to a different layer. 

 Move an Object to an Existing Layer 

 Place Furniture on Specific Layers 

 Use Layers to Get Information in the BOM 

 Installation View 

 Delete Layers 

Move an Object to an Existing Layer 

1. Open a drawing. 

2. In the Drawing toolbat, click main to open the Layer Setup dialog. 
 

 
3. Click Add Layer. 

4. Under Layer name, type Existing. 

5. Under Pen Override, select Dot and click OK to close the New Layer dialog. 

6. Click OK in the Layer Setup dialog. 

7. Make a copy of your workstation and highlight the copied workstation. 
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8. With the cursor on a highlighted line, right-click and choose Move (Dialog). 
 

 
9. Under New Layer for Move, click the drop-down arrow and choose Existing. 

10. Click Perform Move. The selected furniture has now been moved from the main 
layer to the existing layer, and shows as dotted lines rather than solid lines. 

Place Furniture on Specific Layers 

When placing furniture you can specify which layer you will use. 

1. In the Drawing toolbar, click the Existing (layer) button. 
 

 
2. Under Work Layer, click the drop-down arrow and choose main. 
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3. Click OK. 

4. Place the new furniture symbols. The new furniture will draw solid lines to 
differentiate it from the existing pieces. 

Use Layers to Get Information in the BOM 

1. To print a Bill of Materials for the new pieces only, choose BOM, Report on the 
menu bar. 

2. Select Layer. 

3. Click the drop-down arrow and choose main. 
 

 
4. Click Show. This will preview and/or print only the new furniture, which was placed 

on the main layer. 
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Installation View 

In this example, we will create a printout of only the new pieces. To accomplish this, the existing layer 
must be turned off (not deleted). 

1. In the Drawing toolbar, click main. 
 

 
2. In the Layer Setup dialog box, note the sub-layers in the right window. 

3. Click Existing under Layer Selection - this will highlight all the sub-layers of Existing. 

4. Click Off under Display Mode. 
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5. Click OK. Only the new furniture symbols should be showing on-screen. When this 
file is printed, it will only print the furniture showing on-screen. 

6. To turn the existing pieces back on, open the Layer Setup dialog. Under Layer 
Selection, choose All, click On, then click OK. 
 

 

Delete Layers 

Warning: Be careful when deleting layers as this cannot be undone! 

1. In Drawing toolbar, click main to access the Layer Setup dialog box. 
 

 
2. To delete a sub-layer, select the sub-layer to delete under Display Mode. 

 
To delete a layer, select the layer to delete under Layer Selection. For example, to 
delete all the existing furniture, click on existing under Layer Selection. 

3. Click the corresponding Delete button. 
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4. When this warning appears, click OK. 
 

 

Masks 

Display masks allow you to turn on or off the display of certain items in symbols, such as text or 
grommets: 

1. From the menu bar choose Tools, Options or click the Set Options icon . 

2. In the Display Masks Options, click the Masks tab. A list of masks appears in the 
Masks window. 
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3. Check the masks that you want to display. Uncheck the masks that you want to 
hide. 

4. To save this mask style future use, click Save. 

5. Assign a name to the mask style, then click Save. 

6. Click OK to apply the mask. 

Renderings 

 Hidden Line Renderings 

 Color Renderings 

 Perspective Camera 

 Birds Eye View 

 Render Options 

Hidden Line Renderings 

The hidden line rendering is the same as the 3D view with all lines removed that would not appear if the 

model surfaces were solid. The Zoom All icon  can be used in the Hidden Line Render window. Do 
not use the Rotate View icons in the Hidden Line Render window. Rotate the drawing first in the 3D 
window, and then render the Hidden Line. 

Click the Create Hidden Line icon . 

 
Note:  Text can be added to hidden line renderings. 

Color Renderings 

The Color Render window only captures what is currently showing in the 3D window. 

To ensure the full drawing is rendered, click the Zoom All icon , then click the Render 3D Window 

icon . 
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Perspective Camera 

Use the Perspective Camera dialog to set different 3D views of the drawing. For example, you can set 
the view to look as if you are standing in the room looking at the furniture rather than the overhead 
view of a normal 3D, Hidden Line or Color Render window. 

1. Click the Perspective Camera icon . The 2D and Perspective windows appear 
tiled on-screen. The 2D Plan is the camera. 
 

 
2. Choose the desired options described below: 

 
The camera has 4 square boxes on it: 
 
- The black box attached to the camera with a dashed line sets the direction the 
camera is facing. 
- The black box on the camera itself allows the camera to be dragged around the 
screen to set a different angle. 
- The two black boxes at either end of the camera “lens” are used to change the 
zoom factor. 
- To change direction, angle, or zoom place the cursor on one of the boxes (the 
cursor changes to a round cursor with arrows). Hold down the left mouse button 
and drag the box around the screen. When the mouse button is released, the 
changes will appear on-screen immediately. 
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3. The settings in the Camera dialog, default to a forward view: 
 
Camera Ht.: 5’- This represents the eye level of the viewer. 
Lookpt Ht.: 5’- This represents the height that the viewer is looking at 
Angle: 45 - This represents the angle that is visible by the viewer. 
Clip Dist.: 5’ – This represents the distance from the viewer that will be eliminated 
to see items beyond 
 

 
4. Once the view is set, click Save. 

5. Assign a name to the view. 

6. To use saved views in other drawings, click Load in the Camera dialog. 

7. To produce a Hidden Line or Color Render from the perspective view, maximize the 
Perspective window. 

8. Click Zoom All. 
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9. Click the Hidden Line or Color Render icon. 
 

 
Note:  When the Perspective window is open, any render will default to that view. To render the 3D view, 
you must close the Perspective window. 

Birdseye View 

Birdseye gives you a 3D perspective view that allows you to look down on your drawing. To get the full 
effect of this view, do a hidden line or full color rendering. 

1. Click the Birdseye icon . The entire drawing appears in 3D view from above. 

2. Click either Hidden Line or Render. 
 

 
Note: To get a more realistic look draw a floor using 3D objects from the Draw Menu. 
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Render Options 

You can set the options that affect the rendering in the Options tool. 

1. From the menu bar choose Tools, Options or click the Set 

Options icon . 

2. In the Display Masks Options, click the Render tab. 
 

 
 
- You can add shadows to the rendering by selecting a Sun Position 
- Uncheck Edge Highlighting to make the rendering more realistic 
- To show furniture in a room without showing walls, select Transparent Walls 
- The Size Multiplier sets the rendering resolution, if you are going to save the 
rendering for printing you may want to change this. Typically, you would create a 
rendering with a multiplier of 2 or 3 if you wished to save the renderings as bitmaps 
at a higher resolution. If you create an oversize rendering and print it out, you get a 
better quality image than from a normal size rendering. 
- Check Use Textures to use textures instead of colors on entities. Click Textures to 
set surface materials and textures used on rendered items. 

3. Change the options you want to try and click Render Now to see the results. 

4. Click the Background tab. 
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5. Change the color of your background to White or to a Linear blend. 
 

  

6. Click Render Now to see the changes. 

See also: 

 Change Colors 

 Color Maps 

 Save Image Files 

 Transparent Walls 

Change Colors 

1. Click the Render 3D Window icon . 

2. Right-click anywhere on the screen and select Choose Color. 

3. When a message box appears, click on any furniture symbol to change that color. 

4. In the Get Rendering Color dialog choose one of these options: 
 
- choose a new color from the palette 
- use the RGB (red, green, blue) slider bars to set a new color or shade 
- click the Browse button. 
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5. If you clicked the Browse button, the Color Selection dialog appears. Choose a finish 

type (Fabric, Laminate, etc.) from the drop-down menu and a  new color from the 
list, then click OK. 
 

 
6. Click Render Now to see the color change. 

7. To change another color, click Select Color and click on another symbol. 
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Color Maps 

Once the colors are set the way you want them, the color scheme can be saved as a Color Map to be 
reused in future projects. 

1. Click the Render 3D Window icon . 

2. Right-click anywhere on the screen and select Choose Color. 

3. When a message box appears, click on any furniture symbol to change that color. 
In the Get Rendering Color dialog, choose a new color. 
 

 
4. Click Save. 

5. In the Export Color Map File dialog, enter a name for the color map (i.e., grays, 
blues, etc.). 

To apply a saved Color Map to a project: 

1. Access the Get Rendering Color dialog, and click Load. 

2. Select the name of the color map and click Open. 

3. Click Render Now to see the changes. 

Save Image Files 

Any rendering can be saved and sent as an email attachment, or imported into other Windows apps. 

1. Click the Render 3D Window icon . 

2. Click the Import/Export/Style Files icon . 

3. In the Import/Export/Styles dialog, click the Other tab. 

4. Select Image (.BMP or .JPG). 
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5. Click Save to Any Folder. 
 

 
6. Navigate to the folder where the image file must be saved and assign a name to the 

image file, which can be the same as the name of the drawing. 

7. Choose a file type beside Save as type. 

8. Click Save. 

Transparent Walls 

Walls can be changed to lesser transparencies, giving the illusion of being see-through or glass. This is 
particularly helpful when viewing rooms in 3D. 

1. Right-click on the wall that you want to see through and choose Change, 
Transparency. 

2. In the Change Transparency dialog, choose the level of transparency and click OK. 
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3. To change a wall back to solid, follow the same steps, and set the transparency to 
None-opaque. 
 

 

Presentation Extras 

 Floor 

 Ceiling 

 Lighting 

 Decorative Items 

Floor 

Follow these steps to add floors to your presentations and make them more realistic. Here we will use a 
simple 3D object to create an opaque floor to which you can assign materials and colors. 

1. From the menu bar choose Draw, 2D CAD. 

2. In the Draw tab choose the 3D Rectangle icon. 
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3. Using the corners of the building or room draw a rectangle to fill in the floor. 

4. Right-click on the corners of the room or building to snap the carpet/floor covering 
to the exact dimensions of the space. 

Note: If more than one floor covering is used, draw a rectangle for each floor covering. 

The following example shows that adding a floor helps to ‘ground a rendering’. 

 

Ceiling 

Ceilings are only necessary when you use the perspective camera for renderings. Ceilings are removed 
from 3D views so that you can see into a room. 

1. From the menu bar choose Draw, Furniture. 

2. Click the drop-down arrow beside Furniture and choose Misc Furn + Items. 
 

 
3. Choose the Lights/Ceiling tab. 
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4. Click the Ceiling icon under Ceilings. 
 

 
5. Choose the ceiling type and size from the matrix. You may need to piece the ceiling 

together depending on the size of the room. 
 

 
6. When you create a regular 3D view, the ceiling will obstruct the furniture. You will 

need to create perspective views to see furniture once ceilings are placed. Unless 
the ceiling layer is turned off, in which case 3D views will show the inside of the 
room). 

Lighting 

Lighting may be added to the ceiling and walls to make the rendering realistic. The lighting will not 
change the shadows created using the Rendering properties settings. 

1. From the menu bar choose Draw, Furniture. 

2. Click the drop-down arrow beside Furniture and choose Misc Furn + Items. 
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3. Choose the Lights/Ceiling tab. 

4. Select any lighting options you want under Lights. This will help to make renderings 
more realistic. Colors and textures can be assigned to these items. 
 

 

Decorative Items 

Add decorative items to drawings to create realistic presentations. Decorative items include: Art, 
Desktop items, Desktop Clutter, Electronics, and People. 

1. From the menu bar choose Draw, Furniture. 

2. Click the drop-down arrow beside Furniture and choose Misc Furn + Items. 
 

 
3. Choose from the various tabs available. 
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You may need to change your snapping to Surface to place objects on worksurfaces, or you may modify 
the Z-height of certain objects after they have been placed to make the most realistic rendering. 
 

 

Material Assignments 

By adding Material Assignments to your drawing, you have the ability to add your own fabrics and colors 
for a truly accurate and realistic rendering of your space plan. Many manufacturers have fabrics 
available on their website that you may download and use to create a user texture to be applied to the 
drawing. To open the Material Assignments dialog box from within the Lightscape™ dialog, simply click 

on the Material Assignments icon . 

 Textures 

 Properties 

 Color Override 

 User Textures 

 Apply Textures to Specific Items 
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Textures 

Material assignments begin with understanding that all symbols that are drawn in Giza are created out 
of 20 different colors. This can be expanded by utilizing material assignments for individual object. This 
also helps to get all objects that are similar like work surfaces to be the same color and texture. 

1. Click the Material Assignments icon  to access the corresponding dialog box. 
 

 
2. Select the color from the list. 

3. Change the Material Type to Texture. 

4. In the Select Texture dialog, select a Standard Texture (provided by Giza) or a User 
Texture, and then click OK. The texture will be applied on all surfaces that have the 
color 005 as shown below. 
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Properties 

The Properties button in the Texture area allows you to manipulate the selected texture for that color 
number. 

The Scale of the texture may be modified to make it as photo-realistic as possible. 

The texture pattern used may also be set up to repeat in a Mirrored or Tiled fashion. Mirrored allows for 
a pattern to repeat with fairly smooth joints where a tiled texture appears more segmented. The choice 
will depend on what texture is being applied and how large the object is. 

Note: Textures can be applied to something as large as a carpet or as small as a chair arm so the pattern 
and repeat will vary. 

Color Override 

Color override allows you to modify the color of a texture that has been selected. A texture will be 
maintained but the overall color may be modified to more properly match the color scheme of the 
projects. 

1. Once a texture has been selected and the properties set, place a check in the Color 
Override box. 
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2. Click on the color to the right of the check box and select a color from the color 
palette. 

3. The color may be further modified by adjusting the RGB value of the color. 
 

 
4. After the color has been modified choose the Render Now button to see the 

modified rendering. 

User Textures 

You are not restricted to the few textures that Giza provides; you may download textures from 
manufacturers’ websites or scan the texture to get the best looking textures. To add a user texture: 

1. Select User Texture in the Material Assignments dialog box. 

2. Click the Add button. 
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3. Browse for the appropriate .bmp or .jpg image on your computer and choose Open. 
 
Note: The file must already be downloaded to your computer or a server; it cannot 
be taken directly from a manufacturer’s Website. 

4. Provide a Category (this helps to organize the textures), a Name for the texture and 
an approximate Size of the texture image, and then click OK. 
 

 
Note: Providing a size will help the texture to map correctly. If a woodgrain is 6” across the size should 
be 6”. If it is entered as 6’ the graining will seem unrealistic and overly large. After the texture is added 
you can go to the Select function and browse user textures to select the desired texture. 

Apply Textures to Specific Items 

When you assign textures, you have 2 choices: All Items, or Selected Element. Use Selected Element for 
more precise renderings. This is due to the limitation that all symbols drawn fall into just 20 colors and 
symbols of varying textures may fall on the same color. To address this individual object(s) may be 
selected and textures applied to only those items. 
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1. Click the Material Assignments icon  to access the corresponding dialog box. 
 

 
2. Choose Selected Element. 

3. If no item is selected, click the Select Element button to select an object in your 
drawing. Only the colors available for that object will be listed. 

4. Textures and colors may now be applied to these elements. 

5. A worksurface that is of the same color as a panel may receive a different texture to 
meet the overall design concept. 

6. Each color for the selected element receives its own texture/color; some of the 
areas are more obvious than others. 

7. To view the results of the texture mapping, click on the Render Now button when 
the assignments are complete. 

Background Options 

1. Choose Tools, Options from the menu bar or click the Set Options icon . 

2. Click the Background tab in the Options dialog. 
 
Choose a Render Background to determine the backdrop for your renderings. When 
you display a rendering, it is placed in front of the background defined here. 
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You can create eye-catching images by providing an interesting background. You can 
provide: 
 
- Mono- One color on screen- choose color 1 
- Linear Blend- Color 1 on top, Color 2 below 
- Spot Blend- Color 1 in center fading to Color 2 
- Curved Blend- Color 1 on top, Color 2 below but arched 
- Bitmap Image- Any bitmap image can be applied. A single image to fill the 
rendered screen. 
 
 

 

Bill of Materials (BOM) 

1. Click on the BOM pull-down, then select Report. 

2. The BOM Report dialog allows you to choose which symbols will be included in the 
BOM report. 

The default is All in drawing. 

The Show button will show a preview of the report before you print it. 

The Print button will send the report to the printer. 
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The Export button saves the report as a database (.dbf) file, an Excel file (.xls) or a text file (txt). 
 

 

Bill of Materials with Costs and Discounts 

The Bill of Materials can be printed showing list, purchase or sell pricing: 

1. Click BOM/Reports. 

2. Click Costs and Discounts. To show: 
 
- List: Click List and do not enter any discounts. 
- Purchase: Click Client and enter the standard discount (i.e., 50/10/5 or 50/20) in 
Discounts 1 through 3. 
- Sell: Click Client and enter the client discount in Discount 1. 
 

 
3. Click Update Cost Now. 
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4. Click OK to close the confirmation box. 
 

 
5. Click OK to close the cost and discounts dialog. 

6. Click Show to view the report on-screen. 

7. Click Print to print the BOM. 

Export a Bill of Materials to an Excel Format 

Giza has the ability to export the Bill of Materials to an Excel file (.xls): 

1. Click BOM/Reports from the menu bar. 

2. Change any settings and apply Costs & Discounts if needed. 

3. Click the Export button. 

4. Choose the file type Excel. 

5. Click the Export button. 

6. In the Save Report As dialog, enter a file name. Change to a different folder if 
necessary. 

7. Click Save. 

Create a Worksheet from 2020 Giza 

Once 2020 Giza is installed on your computer you can create a 2020 Worksheet directly from 2020 Giza. 

1. Click on BOM > Worksheet. 

2. The Create Worksheet dialog box opens. It allows you to specify what you want you 
want in your worksheet; the entire drawing or selected items only. Selected items 
need to be selected before you access this dialog. Select one of the radio buttons. 
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Worksheet must be closed, however, only an open worksheet of the same name as 
the one being created must be closed. By default worksheets are created with the 
same name as the drawing file, so multiple worksheets created from a drawing 
attempt to overwrite each other. An open worksheet cannot be overwritten. 

3. Click OK to access Worksheet where you can specify line items, add discounts and 
order. 

Print 

 2D or Hidden Line Renderings 

 Color Rendering 

2D or Hidden Line Renderings 

1. Make sure the view on screen is the one you want to print. 

2. Click the Print icon or choose File, Print. 
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3. In this dialog, check Print All Elements in Black. 
 

 
4. If the drawing needs to be printed to scale, choose Print to Scale. 

 
If the drawing does not need to be printed to scale, choose Fill Page With Entire 
Drawing. 
 
To set a specific scale, choose Standard. If necessary, click the drop-down arrow to 
select a scale other than ¼". 
 
To create a custom scale for an item not available in the standard drop-down, 
choose Custom. Use this formula. 12"/desired scale equals the custom scale in 
inches. For example, the desired plot scale is 3/16 so 12”÷3/16= 64” enter the 64 in 
the custom field and that will provide the correct plot scale. 

5. The print origin for scaled plotting allows you to determine where on the paper your 
plot will begin. 
 
- Center Drawing on Page finds the center of the drawing and places it at the center 
of your paper 
- Use Lower Left extent as origin finds the lower left corner of your drawing and 
places it at the lower left corner of the paper 
- Specify center point allows you to choose where the center of the drawing will be 
placed on the center of the paper 
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- Specify lower left origin allows you to choose what you want to be the lower left 
hand corner of the drawing 

6. If desired, click Preview to preview the print job. 
Choose Setup to change the paper from portrait to landscape. What is shown in the 
Setup dialog depends on which printer is installed. 
Click Print to send the job to the printer now. 

Color Rendering 

1. Click the Render 3D Window icon . 

2. Choose File/Print, or click the Print icon . 

3. In the Print dialog, click Print. 

Vignette Plot 

Vignette plot allow for multiple views of the same area to be printed on the same page. This plot 
includes both a hidden line and plan view as well as a Bill of Materials. 

1. Click the Report menu, and select Vignette Plot to open the Vignette Plot dialog. Or 

click the Vignette Plot icon . 

2. Click the View tab to access the View Options. The View options are: 
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Bitmap: A company logo can be included on the printout by checking on the bitmap 
box, then left clicking browse and navigating to the correct .bmp or .jpg file. 
Title: To enter a title, type it in the title field and check Title 
Borders: To print borders, check Print Borders 
Color: The All in Black checkbox tells a color printer to use the black print cartridge. 
This will save color ink (printer mixes all colors to make black if not checked on). 
Color Preview: If the program is set to see 2D in color, this will preview in color. 
Font: Sets the font for the Title and the Bill of Materials. 
Save to Image File: Allows for each page of the Vignette Plot to be saved as an 
image file for insertion or email purposes. 

3. Click the Layout tab to set up the layout of the printed page(s): 
 

 
 
- Page Margins: Usually do not need to be changed - will default to printer defaults. 
- Heights: The height of the Title can be changed - usually .5” is sufficient. The height 
of the image Views (2D and Hidden Line) can be changed. The height of the Report 
(Bill of Materials) can be changed. If it is preferable to have the BOM print on a 
separate sheet of paper, set the Report height to 0”. 
- Widths: The width of each pane can be changed - one for the plan view and one 
for the hidden line render. 
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4. Click the Plot Setup tab to plot to scale: 
 

 
Plot Scaling Method: Choose Plot to Scale to print at a specific scale factor. 
Scale: Use the drop-down arrow to select a standard scale factor. 

Logo 

To add a .bmp or .jpg graphic (such as a company logo) to a drawing: 

1. Click Add Image in the Tools toolbar. 
 

 
2. Click the Choose Image button and locate the .bmp file. 

3. In the Size area, select a sizing option. The options are: 
 
Size With Mouse - after clicking the Place button, hold down the left mouse button 
and drag from the lower left to the upper right. Release the mouse button. 
Screen Size - this uses the same size the bitmap was originally saved as. 
Set Size - Enter a width and height. This depends on the overall size of your drawing. 
Maintain Proportions - It is best to check this box, as the graphic will be properly 
proportioned rather than having a “stretched” appearance. 
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Templates 

Custom templates can be created and saved to be used with any drawing. Templates can contain title 
block information for your company with areas for customer information. If you print at various scales, 
the templates can be created in multiple scales: 

Click File/Drawing Templates/Create. 
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See: 

 Sheet Tab 

 Format Tab 

 Lengths Tab 

 Image Tab 

 Text Tab 

 Scales Tab 

 Select a Template 

 Create New Drawings without Using a Template 

 Apply a Template to an Existing Drawing 
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Sheet Tab 

 

1. Set the paper Orientation to landscape or portrait. 

2. Choose a sheet size using the drop-down arrows or enter a custom size paper 
settings. 

3. Click a Sheet Edge Marks thumbnail to determine where sheet marks will appear. 
Sheet edge marks represent where the edge of the paper is and will let you know if 
something does not fit on a page. 

4. Click whether the sheet marks will appear only on the screen or on both the screen 
and the printout. 
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Format Tab 

Allows you to choose your title block location as well as what type of borders will appear on your 
template. 

1. Select a Title Block Location thumbnail. 

2. Select a border setting. 
 

 

Lengths Tab 

Allows you to decide what type of margins and the size of the title block. 

1. Set the margins. 

2. Set the Title Block Measurements. 
 
If the Title Block Location chosen was the first or last choice on the Format tab, the 
only measurement to be set is Height (default is 2”). 
 
If the Title Block Location chosen was either the second or third option (partial 
page), both Height and Width must be set (Width defaults to 7.5”). 
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Image Tab 

Allows for a logo to be placed on a template on this tab the location and size of the image may also be 
specified. 

1. Click Browse. 

2. Locate and select the .bmp or .jpg image file to be used in the title block. 

3. Set the image location. 
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4. Set the image size. 
 

 

Text Tab 

Allows for individual lines of text to be added to a template. 

1. There are five possible lines of text. Enter the text in the fields. 

2. The buttons to the right of each field will enter the Date Code on that line. The Date 
Code will automatically enter the current date in the title block. 
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Scales Tab 

1. Select the scale sizes for which a template will be created. Multiple sizes can be 
selected. 

2. If the scale desired is not shown, click a drop-down arrow and select the desired 
scale. 

3. Click Create. 
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4. Click OK. 
 

 

Select a Template 

To set a default template to be used when a new drawing is created: 

1. Click File/Drawing Templates/Select Current. 

2. Click Browse. 

3. Select the template to be used and click Open. 

4. Click OK. 

5. Click the New icon or File/New. 

6. To change to a different template, follow the steps above and select a different 
template name. 
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Create New Drawings without Using a Template 

1. Click File/Drawing Templates/Select Current. 

2. Erase the template name in the Drawing tab and click OK. 
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Apply a Template to an Existing Drawing 

Click the File pull down, go to Drawing Templates, and then click on Apply. This allows for an existing 
drawing to accept a new or a revised template. 

Raster Background 

This allows you to import a scanned image of a floor plan, and use it as a background in the 2D view. 

1. Click File > Raster Background. 

2. Click the Browse button to select the saved image to make into the new 
background. 

3. To be sure that the new image is rendered at the specified scale, click Set Register 
Points in Image. 

4. Click and hold on the yellow squares and move each box so that a known dimension 
is represented by the yellow line. 

5. Set the distance to the distance that is known. 

6. Click OK. 
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AutoCAD 

 Import DWG/DXF Files 

 Re-scale DWG/DXF Files 

 Export to AutoCAD 

Import DWG/DXF Files 

This section explains how to import an AutoCAD .dwg file and put the AutoCAD layers on back (ground) 
so furniture can be placed without accidentally selecting or editing an AutoCAD layer. 

1. Click File, Import/Export/Styles. 

2. In this dialog, select AutoCAD drawings. 
 

 
3. Click the Load from Any Folder button. 

4. Select the file to import and click Open. 
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5. In the DXF/DWG Load Options dialog make sure the following are selected: 
 

 
 
From Layers = All Layers. This will insure that everything in the drawing is imported. 
If Active Layers is selected, only the layers that are turned on in the original 
AutoCAD drawing will be imported into Giza. 
To Layers = Original Layers. This will keep the elements in the drawing on the 
original layers they were meant to be on. If Work Layer is selected, then all of the 
objects from the ACAD drawing will be placed on the Work Layer. If Locked ACAD 
layer is selected, all ACAD layers will appear but they will be locked and unable to be 
changed. 
Convert From Units = Inch. 
Check each box for Polylines to lines and faces, Points to nodes, and Dimension 
Blocks to opcodes 
Maintain the value of 1.5 as the Text Width factor 
Blocks to = Symbols. If there are 2020 Giza symbols in the AutoCAD drawing, choose 
Symbols to load the symbols. 
If you are importing a 2020 CAP Designer drawing select Covert CAP Blocks to 
Furniture Symbols. 

6. Click Load.  Furniture can now be placed in the drawing as usual when the import 
completes. 

7. During the import process, a status screen will appear, indicating verifications that 
are being made during the import process. You can Save the Log and then click on 
OK. Refer to the table following this table for all of the possible the Status results. 
None Found (green circle) = Nothing was detected in the source file relating to the 
verification 
Detected  (red circle) = There is an issue that could not be corrected. 
Resolved (yellow circle) = One or more issues were detected and resolved by 
converting the element(s) that caused the issue(s) to a Standard Giza equivalent. 
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Import process question Meaning 

Does the drawing contain corruption? 

Detected- The file cannot be imported because it is corrupted in 
some way. You can contact the file provider and let them know 
that the file is corrupted. Many applications such as AutoCAD 
have functions that can attempt to repair corrupted files. 

Are XREFs detected? 

Detected - The import detected an External Reference (XREF) 
attached to this file.  The import process filtered the XREF; it is 
not part of the results in Giza.  The XREF may not be necessary to 
use the file.  You should contact the provider of the file and ask 
them if any XREF(s) attached to the file is required for your use of 
the file.  

Are frozen layers detected? 

Detected -The import detected that one or more layers are 
"frozen" in the file being imported.  Layers frozen in AutoCAD are 
not visible and modification is restricted.  These frozen layers are 
set to "Off" within the results in Giza. 

Are locked layers detected? 

Detected - Locked layers are set to "Back" in Giza which means 
the import process detected that one or more layers are "locked" 
in the file being imported. Layers locked in AutoCAD are visible, 
but modification is restricted. These locked layers. 
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Are unsupported objects found? 

Detected - Unsupported objects are filtered during the import 
and are excluded from the results within Giza. The import 
detected one or more objects that are not supported by Giza. 
These objects were filtered and they are not part of the results in 
Giza. These unsupported objects are often "AEC" objects which 
come from AutoCAD's Architecture (also known as Architectural 
Desktop). You should contact the provider of the file and ask 
them what might be unusual with the file. Most unsupported 
objects are proprietary to a specific application; the source CAD 
application can usually simplify the items to basic geometry. 

Are any items not set "ByLayer"? 

Detected - Non "ByLayer" items have been left as is. One or more 
of these items have been detected. Their properties have been 
preserved within the Giza results. An example of a non "bylayer" 
item would be a line that is on layer A, where layer A is yellow, 
but the line's color has been set to blue. The line in this case is 
"non bylayer". Therefore, the result in Giza would be a blue line, 
not a yellow one. 

Are there unsupported linetypes? 

Detected - Lines on Unsupported Linetypes have been converted 
to the standard Giza line type. The import process has detected 
that one or more lines were created using a linetype that is not 
supported by Giza. Items that are drawn with these types of line 
lay also be present. Lines and items with unsupported linetypes 
have been converted to use the standard Giza linetype within the 
results in Giza. 

Are there non-supported text styles? 

Detected - Text made using unsupported text styles has been 
converted to use the standard Giza text style. The import process 
has detected that text was made using a text style not supported 
by Giza. This text has been converted to use the standard Giza 
text style within the results in Giza. 

Are there non-supported dimension 
styles? 

Detected - Dimensions made using an unsupported dimension 
style have been converted to use the standard Giza dimension 
style. The import process has detected dimensions that were 
made using a style not supported by Giza. The import process 
filtered these dimensions and excluded them from the results in 
Giza. 
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Re-scale DWG/DXF Files 

Some DWG/DXF files import at an incorrect scale. Use these steps to rescale properly: 

1. Turn all layers from Back to On. 

2. Measure a door or window for which you know the correct size. 

3. Use the following formula to determine the correct scale: Correct Size (CS) / 
Measured Size (MS) = Scale Factor 
 
For example, a door should be 3’ but measures 6’ 6” on screen. Convert to inches 
and divide 36 by 78 to get a scale factor of 0.4615. Or type 36/78 in the X field. 
 

 
4. Select the entire drawing (by either windowing the entire drawing, or by clicking 

Edit/Select/All). 

5. On a highlighted line, right-click and choose Utilities/Scale. 

6. In the Scale Selected Items dialog, enter 0.4615 in the X field. 

7. Select Use X-Scale for all scales. 

8. Click Apply. 

9. Measure the same door again to ensure the scale is now correct. 

Export to AutoCAD  

Any drawing created in Giza (or imported as .dwg/.dxf) can be exported as AutoCAD .dwg/.dxf: 

1. Click File, Import/Export/Styles. 

2. Select AutoCAD Drawings. 

3. Click the Save to Any Folder button. 

4. Type a file name and click Save. 
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5. In the DWG Save Options dialog, the following options should be set: 
Layers: All 
Elements: All 

 
6. Click Save. 

Set Drawing Options 

Choose Tools, Options from the menu bar or click the Options icon   to access the Options dialog. In 
some cases specific tabs can be accessed directly from one of the sidebar menus. See the following 
topics: 

 Notes Options 
 Dimensions Options 
 Polyline Styles Options 
 Display Masks Options 
 Work Plane Options 
 Files Options 
 Display Options 
 Render Options 
 Background Options 
 Walls Options 
 Input Options 
 Unit and Scale Options 
 Drawing Format Options 
 Application Options 
 Window Layout Options 
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Notes Options 

These options apply to the next text entered by the user, or any text created directly by commands 
which do not override these options. 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Notes tab in the Options dialog. 
 

 

Dimensions Options 

To access this tab, click the Dimensions tab in the Options dialog. It can also be accessed by clicking the 

Options icon  in the Dimension tab of the 2D CAD tab menu. 

These options apply to the next dimension entered by the user, or any dimension created directly by 
commands which do not override these parameters. It does not affect previously placed dimensions. 
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1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Dimensions tab in the Options dialog. 
 

 

Polyline Styles Options 

Polylines are lines with thickness that may be used to show specific graphic conditions in a drawing. 
Polylines can be drawn with a defined pattern. They may be used to denote boundary lines. 
 
These parameters apply to the next polyline entered by the user, or any polyline created directly by 
commands which do not override these parameters. 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Polylines tab in the Options dialog to set polyline style parameters and 
choose the polyline style for the next polyline. 
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Display Masks Options 

Use this tab to set up display masks. Display masks allow you to turn off display of certain items in 
symbols, such as text or grommets. 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Masks tab in the Options dialog. 
 

 

Work Plane Options 

Whenever you draw or place symbols with the mouse (as opposed to entering exact values at the status 
line) the point you click is defined as a position in the Work Plane. The Work Plane is defined by an 
orientation and an origin. 
 
A work plane is used when you place items above the floor (not on top of another symbol.) It is also 
used to draw items in a Front, Side or Back elevation. 

1. Choose Tools, Options from the menu bar or click the Options icon . 
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2. Click the Work Plane tab in the Options dialog. 
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Files Options 

Use this tab to modify file settings, such as folder and backup options. 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Files tab in the Options dialog. 
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Display Options 

Use this tab to: 

 change the color of there background, highlighted items, dot grid. 

 choose what to display or hide items in specific windows 

 choose the windows in which you want to draw in black color 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Display tab in the Options dialog. 
 

 

Render Options 

Use this tab to change the default settings of your renderings. These include: 

 shadows 

 edges 

 wall transparency 

 texture use 

 size multiplier 



153 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Render tab in the Options dialog. 
 

 

Background Options 

1. Choose Tools, Options from the menu bar or click the Set Options icon . 

2. Click the Background tab in the Options dialog. 
 
Choose a Render Background to determine the backdrop for your renderings. When 
you display a rendering, it is placed in front of the background defined here. You can 
create eye-catching images by providing an interesting background. You can 
provide: 
 
- Mono- One color on screen- choose color 1 
- Linear Blend- Color 1 on top, Color 2 below 
- Spot Blend- Color 1 in center fading to Color 2 
- Curved Blend- Color 1 on top, Color 2 below but arched 
- Bitmap Image- Any bitmap image can be applied. A single image to fill the 
rendered screen. 
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Walls Options 

Use this tab to set your wall preferences, which include: 

 dimensions (width and height) 

 justification (left, right center line) 

 dimension line display (from the edge or center) 

 snapping settings 

 cleanup 

 2D or 3D walls 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Walls tab in the Options dialog. 

Note: Wall orientation: In the descriptions below, the Starting Point is the first end of the wall, and is 
Edge 1. The Ending Point is the other end, Edge 2. The Left and Right sides of the wall are defined as if 
you were looking at the wall from the top, with the Starting Point up and the Ending Point down. 
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Input Options 

Use this tab to set your input preferences, which include: 

 Rounding and Ruler settings 

 Dot Grid settings 

 Cursor settings 
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1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Input tab in the Options dialog. 
 

 

Unit and Scale Options 

Use this tab to choose your measurement system, unit and drawing scale. 

1. Choose Tools, Options from the menu bar or click the Options icon . 
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2. Click the Units tab in the Options dialog. 
 

 

Drawing Format Options 

Use this tab to choose how to display fractions, marks, separators, and zeros. 

1. Choose Tools, Options from the menu bar or click the Options icon . 
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2. Click the Format tab in the Options dialog. 
 

 

Application Options 

Use this tab to choose preferences on: 

 saving files 

 tooltips 

 stack-on panel warnings 

 various display options 
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1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Application tab in the Options dialog. 
 

 

Window Layout Options 

Use this tab to choose options for the layout of drawings and display windows. 

1. Choose Tools, Options from the menu bar or click the Options icon . 

2. Click the Window tab in the Options dialog. 

3. Directly beneath the screen layouts are numbered boxes which correspond to the 
numbers in the screen layouts.  For each of these, select the desired view from the 
list. 
 
Select 1 to display only one type of window. The window is maximized on your 
desktop. If selected, these settings are used each time you run the application. 
Otherwise, a default window is loaded. 
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4. Click Apply, and then OK. 

  



161 

Update a Giza Drawing from a Visual 
Woksheet 
You can update the drawing with Worksheet information with no regards to any added or deleted part 
in Worksheet. Make sure to choose a worksheet created from the current drawing. 

1. Click Update With Visual Worksheet   on the Tools Toolbar. 
 

 
2. Click Apply. 

See Visualize in Visual Impression 

Visualize in Visual Impression 
Using 2020 Visual Impression in addition to Giza benefits everyone in the sales cycle. It keeps the 
designers in control of product configuration and design while allowing those who are interfacing with 
the customer the ability to make required tweaks needed to close the sale. Customers are now able to 
“see” what they are getting rather than “interpret” it from floor plans, brochures, and product catalogs. 

2020 Visual Impression simplifies both the learning curve and the time needed to create high quality 
presentations making visualization feasible for every project. 

All users of 2020 Visual Impression can create high quality presentations using the assets built into the 
process of visualizing the scene. These assets are collected in one place for the user to save, copy or 
drag-and-drop into their favorite presentation software, such as Microsoft PowerPoint. 

In addition to specifying finishes in Worksheet, 2020 Visual Impression allows the user to visually specify 
items and see the finishes apply to the item as they are being specified. Users can experiment with color 
schemes by applying finishes to products and changing them until the desired results are achieved. The 
resulting specifications can be saved back to the worksheet or drawing file. 
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Using 2020 Visual Impression, finishes can be changed and manipulated to meet the customer’s 
preferences. Product or configuration changes can be annotated and sent back to design for required 
drawing revisions. This smooth’s the communication path between those who are creating the drawings 
and those presenting to the customers and making revisions for the final order. 

See: 

 Define a Scene for Visual Impression 

 Edit a Scene 

 Go to Visual Impression 

 Update a Giza Drawing from a Visual Woksheet 

Define a Scene for Visual Impression 

Visual Impression can treat the entire drawing as a scene, but performs best when your drawing is 
organized into scenes around different points of interest that you want to call attention to. Performance 
can vary by machine and by the complexity of the items you include in your scene. 

Visual Impression saves your room configuration back to Giza Designer. If a scene is not defined and the 
room information is applied back to the entire drawing, future product additions to the drawing may 
appear outside of the original room dimensions. If scenes are defined in the drawing and you make 
additions that move outside of the room dimensions, the scene can be deleted allowing you to redefine 
your scene from scratch. If you anticipate additions to your drawing, it is best to define scenes before 
you go onto Visual Impression. Scene components also may be resized and/or moved to allow for more 
furniture items that might appear outside of the saved room’s dimensions. 

To define a scene for Visual Impression: 

1. Click the Create Scene Bond icon   in the Tools toolbar. 
 

 
2. Click the Draw Boundary button to go back to the drawing, define the boundary 

around the items you want to be part of the scene and then press Esc. 
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3. Back to the Define a Scene dialog box, select a Layer for that scene and then click 
Next. 

4. Enter a Name and a Description for the scene and click Finish. 
A scene boundary tag is displayed in Floor Plan view. 

See also: 

 Manage scenes 

 Go to Visual Impression 

Edit a Scene 

You can add or delete a scene for Visual Impression. This helps you organize, name and keep all scenes 
as you manage your drawing. 

1. From the Tools toolbar menu, click the Edit a scene icon . 

2. Click New Scene or select a scene and click Delete Scene (no confirmation asked). 
 

 
3. Click Close when done. 
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Go to Visual Impression 

To visualize a scene in Visual Impression: 

1. Click the 2020 Visual icon  in the Tools Toolbar. 

2. When Visual Impression opens and displays the Select Scene pane, choose a scene. 
If no scene was created, then the entire Giza drawing shows up in Visual Impression. 
Click BACK to return to your drawing in Giza Designer. 
 

 
3. Specify your products in 3D using all the presentation tools. 

Refer to the Visual Impression Quick Tour Help file to learn about 3D specification. 
 
To learn about training, contact commercial.support@2020.net. 

See also: 

 Help file on Visual Impression 

 Manage Scenes 

 Define a scene for Visual Impression 

 Update a Giza Drawing from a Visual Woksheet 

  

mailto:commercial.support@2020.net
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Giza Automation 
Giza has features that simplify the design/specification process and provide more accurate product 
orders. 

See: 

 Auto Hardware 

 Giza Frame Designer 

Auto Hardware 

Auto Hardware automatically places hardware such as trims and connectors. This feature may not be 
available for all manufacturers. The hardware not only appears on screen but; it is also added to the Bill 
of Materials. 

1. From the menu bar choose Tools/Auto Hardware. The Auto Hardware dialog 
opens. Different hardware will be listed depending on which manufacturer library is 
open. 
 

 
2. Check the box(es) next to the hardware to place. If there are multiple product lines 

within a drawing any product that has Auto Hardware available will appear in the 
dialog. You may choose to place all connectors or deselect any options depending 
on the project. 
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3. Under Apply to, choose All. You may also choose an area of a drawing or a 
previously selected selection set. 

4. Under Product Lines, choose either the Current (Library) Only or All Product Lines 
in the drawing. 

5. Check Create Report of Hardware Added to verify if the correct connectors have 
been placed. 

6. Click OK. The hardware will appear on screen and will be added to the Bill of 
Materials. 

To remove the hardware, click Tools/Delete Auto Hardware.  If you make changes to your layout, 
always delete Auto Hardware before re-running Auto Hardware. 

Giza Frame Designer 

Frame Designer simplifies panel frame configurations in Giza. When you create and apply a frame design 
to frames in your project, Giza Frame Designer automatically inserts tiles, top caps, stack-ons, and 
segment kits. Frame designs can be shared across projects and even shared with Worksheet projects. 

Build a workstation using base frames and stack-ons as required for project. Use the example below: 
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Assign Frames 

This Assign Frames dialog is only available if you have manufacturer libraries that support 2020 Giza 
Frame Designer. It allows you to create, modify, apply, delete, import, and export frame designs. Also, 
you can print the Frame Design report and view a Bill of Materials (BOM). The 2020 Generic catalogs 
support Frame Designer for your perusal. 

1. Click the Frame Designer icon  to display the Assign Frames dialog. 
 
Or, from the Tools menu select Assign Frames. 
 

 
2. Click the Define Frame button to begin creating the first frame configuration. 
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Specify Structural Elements 

1. Click the Frame Designer icon . 
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2. Click the Define Frame button. The Frame Designer dialog box appears. 
 

 
3. Select Panel Frame and 48.00. This will set up the design for the appropriate frame. 

4. To add the stack-on frame, right-click in the Add-On section to add, change, or 
remove an add-on frame. Choose Add-on and then 12" H Stacking Frame. 

5. To specify segment kits for individual tiles, right-click-in a slot to choose a Segment 
Kit and the appropriate size. This allows smaller tiles to be specified. To remove a 
Segment Kit, right-click on it again and select the checked segment kit to uncheck it, 
or, select a different new one. 
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Specify Top Caps and Tiles 

1. Click the Frame Designer icon . 
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2. Click the Define Frame button. The Frame Designer dialog appears. 
 

 
3. Specify a tile and the top cap for each position on each side as follows. 
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- Select a top cap or a tile from the drop-down list. The Option Set field can now be 
tagged. This allows for easy selection of finishes once a BOM is created using Option 
Sets. These Option sets must correspond to the option sets created in Worksheet. 
- Click the box just to the right of the drop-down to display the Color dialog. Select a 
color. This is meant to more accurately represent the finishes in the 3D drawing. 
- Specify an option set name. F1 For a specific fabric color and F2 for a different 
fabric color. The tiles will be counted differently in the BOM. Any name can by 
assigned to the option sets. 
 
Note: The selected tile may affect the tile on the opposite side. 

4. Click the Save icon  to assign a name and a description to the frame. The Design 
Name can be up to 15 characters and the Description up to 20 characters. Special 
characters are not allowed in the Design Name. A warning will appear if invalid 
characters are used. 
 

 

5. Click the Print icon  to print the Frame Design report. If you want to preview the 
frame design or view a BOM for the design, click the Preview tab. 

Apply Frame Designs 

1. Click the Frame Designer icon . 

2. In the Assign Frames dialog box, select the frames that will receive the frame 
design. 

3. Select the design you wish to apply in the Frame Design area from the drop-down. 

4. Under Apply Frame Design, you can choose to apply the Frame Design to a Single 
frame or to a Selection of panels. 

5. Under Show Tile Symbols, select if you choose to place tiles to All, Area or a 
Selection Set. 
 
- All shows the tiles on all the applicable panel frames in the drawing that have been 
assigned a design 
- Area places tiles in a specific area of your drawing. You will be prompted to define 
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the area using the mouse. 
- Select Selection Set places tiles in a selection set you have defined 

6. Check Automatically Swap Frame to automatically replace the frame in your project 
with a frame type and height from the selected design. 
 
Note: If you choose automatically swap frame and a frame you have selected is not 
of the same height as the design you have in your drawing it will change the frame 
to be of the same configuration. This is a good thing if the customer has changed 
their mind. 

7. Check Hide All if you want to hide tiles in either the 2D or 3D drawing screens. 

8. Check Log errors if you want to log errors that may be generated when you apply 
the design. 

Validate Frame Designs vs Panel Frames 

This will verify that each tile that is applied to a frame configuration is valid and can be built. 

1. Click the Frame Designer icon . The Assign Frames dialog appears. 

2. Click Validate to check frame designs against all panel frames. Errors for 
incompatible frames appears in the Panel Design Errors dialog. 

3. The Panel Design Errors dialog will display. Select Highlight Panel Frames with 
errors, Show errors in Notepad, or Both. 

Highlight Panel Frames with errors highlights those frames in the drawing window. 

Show Errors in Notepad opens the validate.txt file in Notepad and lists the errors 

Both highlights problem frames and opens the Notepad document for referral. 

Tag the Frames with the Frame Design Name 

Tagging frames is a helpful tool when working on large-scale projects where configurations can be 
spread throughout a drawing. This makes selecting all of the panels that will receive a specific 
configuration much easier. 

1. In the drawing window, select all of the panels that will receive the “Frame 1” 
configuration in the drawing. 
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2. Right-click on any highlighted item and choose Change, Tag. 
 

 
3. In the dialog, type Frame 1 and click OK. That tag is now be applied to all selected 

frames. 

4. From the menu bar choose Edit, Select, By Attribute. 

5. Now that the items are selected, click the Frame Designer icon  to choose the 
appropriate frame design and apply it to the selection. 

Edit Frame Designs 

1. If an incorrect Frame Design is assigned, select the frame. 

2. Right-click on a highlighted item and select Edit Frame. 

3. Make all changes to the Frame design and save the changes. 
You need to apply the frame design again to display the edited design. 

Export Frame Designs 

1. Click the Frame Designer icon . 

2. In the Assign Frames dialog, click the Define Frame button. 

3. In the Frame Designer dialog, click the Export icon . 

4. In the Export Design dialog, click New and assign a Design Set name (this will allow 
you to group frames that you want to reuse). 
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5. Select the frame designs to export in the Designs area. To select a range of designs, 
click the first design, hold down the SHIFT key, and then click the last item in the 
range. To select a noncontiguous group of designs, hold down the CTRL key and click 
the desired designs. 

6. Click Export. 

Import Frame Designs 

1. Click the Frame Designer icon . 

2. In the Assign Frames dialog, click the Define Frame button. 

3. In the Frame Designer dialog, click the Import icon . 

4. In the Import Design dialog, select the source in the Import From field. You can 
choose Giza Project or Design Sets, select a project or design set to import. 

5. Select frame designs to import in the Designs area. 

6. Click Import. 

Create a BOM with Frame Designer 

1. Select the BOM pull down then select Worksheet. 

2. Click either Entire drawing or Selected Elements. 
 
If you would like to create BOM for a specific area of a drawing select the frames 
then choose Selected Items Only. In Worksheet the Frame Designs will have to be 
imported and updated in order for the tile elements to be included in the project. 

For more information about working with Frame Designs in Worksheet, see the Frame Designs section in 
the Worksheet help. 

Consolidate Frame Components 

The Frame assemblies will help with checking the specification but before placing an order you will need 
to combine like items such as tiles and frames. 

1. Click the 2020 Worksheet icon . 

2. Choose the Frame/Unlink. 

3. When prompted “Unlink frames in project?”, select Yes. 
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4. Choose Modify/Consolidate to combine like items. 
 

 
5. Sort the file by Product number or Description. 

 

 
6. Choose Modify/Resequence to reset the sort numbers. 

Frame Designer Preferences  

Allows for some features within Frame Designer to be customized. 

1. Click the Frame Designer icon . 

2. In the Assign Frames dialog, click the Define Frame button. 

3. In the Frame Designer dialog, click the Preferences icon . 
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4. In the Design section, check the required options described below. 
 

 
Clear option set when element is changed: If a tile is changed from fabric to laminate it will assume that 
the option set chosen will also change. Uncheck the option to allow for the same option set to continue 
to be applied without retyping the information. 

Select default color when element is changed: If a tile is changed from, fabric to laminate, for example, 
it will assume that the color of the element will also change. Uncheck the option to allow the same color 
to continue to be applied without reselecting. 

Include color during duplicate design check: Frame Designer compares colors when checking for similar 
designs with other Frame Design names. When this option is disabled, the program ignores the color 
and will state that similar configurations exist even when the colors are different. 

Show controls only for active slot: Hides all other slot selections, essentially “locking” the selections. 
Only chosen selections are visible. 
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Advanced Topics 
 Advanced Typical Placement 

 Make Symbol 

 Giza Specials 

 Columns 

 Check Drawing Integrity on Save 

 Check Drawing Integrity of an Area 

 Inventory Management 

 Giza Publisher 

Advanced Typical Placement 

Advanced typical placement allows items to be placed on their original layers or other work layers or 
manage attributes that may have been associated with a typical when it was created 

1. From the menu bar choose Draw, Typical. 

2. In the Place Typical dialog, click the Advanced button to access the Typicals 
Advanced dialog. 
 

 
3. Under Place on Layer, you may choose to place the typical on the Current working 

layer of the drawing or on the original layers that the typical was created on. 
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4. Under Attributes Values, select the appropriate option. 

5. Check or uncheck Highlight Overlapping Panels After Edits. 

6. Check Use Mirroring if you would want to mirror the typicals being placed in the 
Grid or Radial format. Set the mirroring preferences accordingly. Click the Mirroring 
Sample button for a sample of how the typical will be placed with the mirroring 
preferences you choose. 

7. Click Exit to return to the Place Typical dialog. 

8. Click Place to place the typical into the drawing. 

Make Symbol 

Create your own 2D symbols - in this example, we will create a symbol that represents a stool: 

1. Click the Draw CAD icon . 

2. Click the Circle icon. 
 

 
3. Click in the drawing area and draw a circle to represent a stool. 

4. Click the Stop icon . 

5. Right-click on the circle and choose Utilities, Make Symbol. 
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6. In the Make Symbol dialog, enter Stool in the Name field. 
 

 
7. Under Origin, select Center. The origin point is determined by the object that is 

being created. 

8. Check Replace selected items with the new symbol to replace any existing symbol 
with the same name. This will remove the circle from the drawing and replace it 
with the symbol that was just created. 

9. Click Make. 

Place User-Defined Symbols 

1. Click the Draw CAD icon . 
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2. In the 2D CAD icon menu, click the Symbols tab. 
 

 
3. Click the User button at the bottom of the menu. 

4. Choose List to see a text list of user-created symbols. 
 

 
5. Choose Gallery to see user-defined symbols. 

6. Click on the symbol to place and click Place. 
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20-20 Giza Designer 

Giza Designer allows you to create custom sized furniture symbols based on a manufacturer’s symbol or 
to create a symbol based on a .dwg or .dwf file. 

See: 

 Launch 2020 Giza Designer 

 Stretch Symbols 

 Edit Text Labels 

 Import DWG Files into 2020 Giza Designer 

 Save Symbols 

 Edit a Category 

 Return to Giza 

 Select the User Library 

Launch 2020 Giza Designer 

1. Click the Special Symbol Creation icon  or choose Draw, Special Symbols from 
the menu bar. 

2. Click OK in the following box. 
 

 
3. Select a furniture symbol that is the closest representation of the symbol you want 

to create. Notice that the selected symbol immediately jumps to the 2D and 3D 
windows. To change the manufacturer library, choose File, Open Manufacturer 
from the menu bar. 
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Stretch Symbols 

1. Access 2020 Giza Designer and select a furniture symbol without curves. 

2. Click the Stretch Current Symbol icon . 

3. Place the cursor in the drawing area (depending on how the symbol will be 
stretched). You cannot stretch curved furniture symbols. In this example, you will 
stretch the right side of a worksurface and change the dimensions to 66” X 24”. 
 

 
4. Hold down the left mouse button and drag a window around the area to stretch. 

The selection box is represented by a dashed line rectangle. Release the mouse 
button. 

5. In the Stretch dialog, enter the distance you wish to stretch the symbol in the 
appropriate fields. The direction of the arrows indicates the direction of which the 
symbol will be stretched. If you need to change the direction of the stretch, simply 
click on the arrow to reverse the direction. 
 

 
X Distance refers to the horizontal (left and right) coordinates 

Y Distance refers to the vertical (top and bottom) coordinates 

Z Distance refers to the elevation (floor and ceiling) of the symbol 
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Edit Text Labels 

As most symbols contain some form of text, such as the dimensions, you may need to edit the text to 
match the changed dimensions. 

1. To edit the text, right-click on it and choose Edit Single. Or, if you have multi-line 
text, choose Edit Paragraph. 

2. Make any changes to the text as necessary and click Replace Text. 

Import DWG Files into 2020 Giza Designer 

 2D and 3D symbols that are available in AutoCAD can be imported into 2020 Giza Designer (choose 
File, Import from the menu bar) 

 3D graphic must be composed of 3D Faces only 

 Symbols can be edited and modified as necessary for the new symbol 

Save Symbols 

1. To save the symbol in the User Library, click the Save icon  or choose File, Save 
Symbol from the menu bar. 

2. In this dialog, enter a new symbol Name under Symbol Identification. It must be 
different from the current symbol name. 
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3. The Category section defaults to User Library. To save new symbols in a different 
category, click the drop-down arrow and choose another one. 

4. You can change the MFGR (manufacturer name) of the symbol by editing the text in 
the field. 

5. Change both the PARTNO (part number) and DESC (description) to accurately 
represent the new symbol. 

6. If applicable, enter a COST for the symbol. 

7. To change the LAYER in which the symbol will be placed in the drawing, enter 
another layer name in the field. 

Edit a Category 

1. To create, edit, or delete a category for your symbols, choose File, Category Edit. 

2. In the Category Editor dialog:, click Add to add a new category. 
 

 
3. Enter a new category name and click OK. 

4. Click the Right button to demote the new category to a sub-category. 
 
Click the Left button to promote a sub-category. 
 
Click the Delete button to remove the selected category or sub-category. 
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Return to Giza 

1. After saving a symbol, click the Return to Giza icon or choose File, Return to 
Giza from the menu bar. 

2. Click OK when this message appears. 
 

 
3. When prompted, choose Yes to regenerate the display list of the User Library. The 

User Library will be updated with the newly created symbol. 

Select the User Library 

1. To retrieve and insert a symbol from the User Library, choose File, Select Product 
Line from the menu bar. 
 

 
2. Under Manufacturer, select User. 

3. Under Product Line, select Library. 
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4. Click OK. 
 
You may now place the special symbol you have just created. 

Note: The symbol can be used in any drawing at any time simply by loading the User Library and placing 
the desired furniture symbol. 

Columns 

1. Click the Draw Walls icon . 

2. Click the Place Column icon from the walls icon menu. 
 

 
3. In the Columns dialog box, select the required column shape (square or round). 

 

 
4. Set the Height of the column. Note that columns are typically the same height as 

the walls within that area. 
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5. For square or rectangular columns, set the Width and Depth of the column. For 
circular columns, set the Diameter. 

6. Under Placement Mode, choose Single. 

7. Click the Place button. 

8. Click anywhere in the drawing area where the column should appear. Or, to 

precisely place the column, click the Point Input icon . 

 

Try this yourself! Place a 2' x 2' square column 5' from the left wall, and 2' up from the bottom wall: 

1. In the Point dialog, type 6' in the X field. 

2. Type 3' in the Y field. Note that for rectangular and square columns, add half the 
width and depth of the column, since they are placed using the center of the column 
as its insertion point. That is why in this example we enter 6' in the X field and 3' in 
the Y field. When placing circular columns, add one-half of the diameter of the 
column. 
 

 
3. Make sure the directional arrows are pointing right and up, respectively. 

4. Check From Fixed Point. The fixed point is the point on the drawing area that the 
program will measure from. In this case, the bottom left corner of the room. 

5. Click the Enter Point button. 

6. Move the center of the crosshair just inside the bottom left corner and right-click to 
place the column. 

  



189 

Place Columns with the Grid Command 

Note:  When calculating the distance between columns, the program measures from the center of 
columns. Therefore, add half of the width/depth or diameter your placement calculations. 

1. Click the Draw Walls icon . 

2. Click the Place Column icon from the walls icon menu. 
 

 
3. In the Columns dialog box, select the required column shape (square or round). 

 

 
 

 For square or rectangular columns, enter the Height, Width and Depth 
 

 For circular columns, enter the Height and Diameter 
 

4. Under Placement Mode, select Grid, then click the Place button. 
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5. To place the column at a precise location, click the Point Input icon . 

6. After placing the first column, the status bar shows Next column in row 
(horizontally)... 
Place the second column using the Point Input dialog. Remember! Add half of the 
width/depth or diameter! 
 

 
7. After placing the second column, the Input dialog asks you for the total number in 

each row. 
 
Enter the total number of columns then click OK. 

8. Determine the spacing between the (vertical) rows. 

9. Click the Point Input icon  and choose the spacing. 

10. In the Input dialog, enter the total number in each row. 

11. Click OK. 

Check Drawing Integrity on Save 

Giza has the ability to check the integrity of a drawing while saving that drawing. Drawing integrity does 
the following: 

 finds invalid and duplicated symbols 

 remakes all walls 

 validates all stacked frames 

 finds invalid attributes and overlapping panels 

 validates frame designs 
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1. To automatically check each file, choose Tools, Options from the menu bar or click 

the Set Options icon . 

2. Click the Application tab. 

3. Check Validate Drawing on Save and click OK. 

To modify the list of options that Drawing Integrity looks for, choose Tools, Drawing Integrity from the 
menu bar. 
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Check Drawing Integrity of an Area 

The Check Drawing Integrity function can be used on a selected area or an entire drawing. Check Area is 
useful when you have a large drawing and only want to check the frame design on a certain area. Any 
feature of Drawing Integrity may be done to only a selected area of the drawing. 

1. Choose Tools, Drawing Integrity from the menu bar. 

2. Check the required options in the following dialog box. 
 

 
3. Choose Check Area at the bottom right of the dialog box and click OK. 

4. To select the area, position the cursor near the symbols. 

5. Click once and move the cursor so the area is enclosed within the dashed line box. 

6. Click again to set the area. 
 
A report is generated. 

Note: An integrity report should ALWAYS be viewed after running Integrity Check. 
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Inventory Management 

Inventory Management allows you to compare your current layout with up to two other files. By reusing 
parts that are in an existing layout for the same space, or even parts that are in storage, you can reduce 
the number of new parts that you must order for a new layout. This feature works with CDB (design) 
files only. In the following example, Existing. CDB is the original office layout sold last year. The same 
company has decided to expand and New. CDB is the new layout. 

 

Compare CDB Files with Inventory Management 

1. Choose to File, Open from the menu bar. 

2. Select the new layout file (new.CDB). 

3. Choose to Tools, Inventory from the menu bar. 

4. In the Inventory Management Files dialog, the Existing Layout File represents the 
existing layout. Click Pick Existing and select the file name (existing.CDB). 
 

 
5. The inventory file can be skipped in this example since we are comparing two files 

only. Therefore, empty the Inventory File field and click OK. 

6. In the next the box, click Continue to compare the two files or click Return to go 
back and specify an inventory file. 
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Note:  If you do not have an existing layout, leave the field empty. You will be 
notified that no Existing Layout File was found. Click Continue to search the 
Inventory File. 
 
In the Done message box, click OK. You may now generate a Bill of Materials (BOM). 
 
new - items that need to be purchased 
inv - items in the warehouse or inventory files that are needed for the project 
ext - items that already exist from the previous layout 

View a BOM 

1. Choose BOM, Report from the menu bar. 

2. In the BOM Report dialog, select All in drawing. 
 

 
3. Click Show. 
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4. All symbols are now tagged in the Other column. 
 

 

Generate a BOM with New Items Only 

1. From the menu bar choose Edit, Select Set. 

2. In the Selection Set dialog box, click the drop-down arrow beside Attribute and 
choose Other. 

3. In the Pattern field type, select new. All line items wlll have new as their Other 
attribute. 

4. In the Add to Selection Set section click All. 

5. Click Exit. 

6. Click the BOM, Report menu. 

7. In the BOM Report dialog box, choose Selected Elements. 
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8. Click Show. The report displays the highlighted (selected) items only. 
 

 

Giza Publisher 

A Giza Publisher document can contain up to four pages. Every page can show from one to several types 
of information, including directly entered text, imported text, bitmaps, plan view, hidden line view or a 
rendered image. A variety of layouts are available for organizing the information. Publisher layouts can 
be saved and reused on other projects. Publisher documents can be printed as hard copes or output as 
web pages. On the next several pages is an example publisher project with the following components: 

 The first page includes your company logo, company information, who the document is prepared for 
or an attached text file. (Note that Publisher can only attach files with the extension .txt. To attach a 
Word document, save it in a .txt file format first). 

 The second page includes the 2D plan view 

 The third page includes a Hidden Line view and a Color Rendering 

 The fourth page includes the Bill of Materials 

Create a Publisher document 

1. Choose File, New to start a new drawing or click the Create New Drawing icon . 

2. With the Generic GNRC product Line selected, click the Media Program icon . 
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3. In this window, select the Panel Layout 3. 
 

 
4. Click on the picture on the right. The Place Typical dialog appears. 

5. Click the Place button. 

6. Click to place the typical. Click the Stop icon  to cancel the typical command. 
 

 

7. Click the Hidden Line Render icon . When the drawing appears, click the Zoom 

All icon  (for your own drawings, you also want to create a Color Render and 
save it as a .jpg or .bmp file). 

8. Click the Publisher icon . 
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Page One 

1. In the Giza Publisher dialog box, click the Change Layout button. 
 

 
2. In the dialog that appears, choose this layout. 
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Note: In this example we will place a logo centered on the top and the customer 
information centered on the bottom. 

3. In the Giza Publisher dialog, click the upper frame. 

4. To the right, under Type, click the drop-down arrow, choose Bitmap File. 

5. Click the Contents button, a dialog appears. Click Browse and locate the file to be 
inserted (any currently available bmp). 
 

 
6. Click the lower frame. 

7. To the right, under Type, click the drop-down arrow. Choose Text. 

8. Click the Contents button. A dialog will appear where you can type in the text. 
(Customer information). 
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9. Set the Border Type to None. 

Page Two 

1. In the Gize Publisher dialog, click Change Layout and choose the icon in the first 
row, in the second column. 

2. Under Type, click the drop-down arrow and choose Plan View. 
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3. Set the Borders to None. 
 

 

Page Three 

1. In the Giza Publisher dialog, click Change Layout and choose the icon in the second 
row, in the fourth column. 

2. Click the upper frame. 

3. Under Type, click the drop-down arrow and choose Hidden Line View. 

4. Click the bottom frame. 
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5. Under Type, click the drop-down arrow and choose Rendered Image. 
 

 
6. Click on the Contents button to alter the default Rendered image. Select the type of 

scaling for the rendered image. Then, choose what will be visible, choose All layers, 
Layers, Symbol or Typical. Symbols or typicals can be rotated differently than the 
hidden line drawing. 
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7. Set the Border Type to None. 
 

 



 

204 

Page Four 

Giza Publisher automatically prints the Bill of Materials on the last page. 
 

 

Header and Footer 

1. If you want a headers and/or footers, click the Header and Footer icon in the  
Giza Publisher dialog box. 
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2. Select the required options in the following dialog. 
 

 

Print Preview 

To see a preview of the Publisher document, click the Print Preview icon. 
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Save Layout as Template 

1. To save a layout as a template to be used in the future, click the Save icon. 
 

 
2. Assign a name to the template in the Save As dialog and click Save. 
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